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Preface

This guide is the primary source of user and reference information on the Oracle
Application Server Integration Adapter for CICS, which enables client applications
to access programs running under CICS through the Sun 2JEE Connector
Architecture (JCA) APL

This document describes the features of Oracle Application Server Integration
Adapter for CICS software that apply to the IBM OS/390 and z/OS Series,
Windows NT, Windows 2000, Windows XP, and Windows Server 2003 operating
systems.

This preface covers the following topics:

Audience

Organization

Related Documentation
Conventions

Documentation Accessibility
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Audience

This manual is intended for Oracle integration administrators who perform the
following tasks:

» Installing and configuring the Oracle Application Server Integration Adapter
for CICS

= Diagnosing errors

= Using Oracle Application Server ProcessConnect to access CICS programs

Note: You should understand the fundamentals of Oracle
Application Server ProcessConnect and the IBM OS/390 and z/OS
series and Microsoft Windows operating system before using this
guide to install or administer the Oracle Application Server
Integration Adapter for CICS.

Organization

This document contains:

Chapter 1, "Overview of Oracle Application Server Integration Adapter for
cics"

This chapter introduces the Oracle Application Server Integration Adapter for CICS.

Chapter 2, "Installing the Oracle Application Server Integration Adapter for
cics"

This chapter explains how to install Oracle Connect for CICS on an IBM OS/390 or
z/OS series operating system and Oracle Studio on a Windows platform.

Chapter 3, "Modeling Interactions for Oracle Application Server Integration
Adapter for CICS"

This chapter describes how to model interactions in Oracle Studio.
Chapter 4, "Using Interactions in a Business Process"

This chapter describes how to include Oracle Connect for CICS interactions in a
business process in Oracle Application Server ProcessConnect.
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Chapter 5, "Oracle Application Server Integration Adapter for CICS Features"

This chapter describes specific features of the Oracle Application Server Integration
Adapter for CICS.

Chapter 6, "Troubleshooting the Oracle Application Server Integration Adapter
for CICS"

This chapter describes how to troubleshoot problems both during modeling and
runtime.

Appendix A, "The Oracle Connect CICS Interaction Metadata Definitions"
This appendix describes the metadata for Oracle Connect for CICS.

Appendix B, "Datatype Support"

This appendix describes how COBOL datatypes are converted to Oracle Connect
for CICS datatypes and Oracle datatypes.

Appendix C, "Daemon Configuration Settings"

This appendix describes daemon configuration used to control client/server
communication.

Appendix D, "COBOL APIs to Applications"

This appendix describes how to access the Oracle Application Server Integration
Adapter for CICS from a COBOL program.

Related Documentation
For more information, see these Oracle resources:
»  Oracle Application Server ProcessConnect User’s Guide
Printed documentation is available for sale in the Oracle Store at

http://oraclestore.oracle.com/

To download free release notes, installation documentation, white papers, or other
collateral, please visit the Oracle Technology Network (OTN). You must register
online before using OTN; registration is free and can be done at

http://otn.oracle.com/membership/
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If you already have a username and password for OTN, then you can go directly to
the documentation section of the OTN Web site at

http://otn.oracle.com/documentation/

Conventions

This section describes the conventions used in the text and code examples of this
documentation set. It describes:

= Conventions in Text
= Conventions in Code Examples

= Conventions for Windows Operating Systems

Conventions in Text

We use various conventions in text to help you more quickly identify special terms.
The following table describes those conventions and provides examples of their use.

Convention Meaning Example

Bold Bold typeface indicates terms that are When you specify this clause, you create an
defined in the text or terms that appear in index-organized table.
a glossary, or both.

Italics Italic typeface indicates book titles or Oracle9i Database Concepts

emphasis. Ensure that the recovery catalog and target

database do not reside on the same disk.

UPPERCASE Uppercase monospace typeface indicates  You can specify this clause only for a NUMBER
monospace elements supplied by the system. Such column.
(fixed-width) elements include parameters, privileges, .
font datatypes, RMAN keywords, SQL You can back up the database by using the
keywords, SQL*Plus or utility commands, :
packages and methods, as well as Query the TABLE_NAME column in the USER_

system-supplied column names, database TABLES data dictionary view.
objects and structures, usernames, and

roles Use the DBMS_STATS.GENERATE_STATS

procedure.
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Convention

Meaning

Example

lowercase Lowercase monospace typeface indicates Enter sglplus to open SQL*Plus.
monospace executables, filenames, directory names, . R .
(fixed-width) and sample user-supplied elements. Such The password is specified in the orapwd file.
font elements include computer and database  Back up the datafiles and control files in the
names, net service names, and connect /diskl/oracle/dbs directory.
identifiers, as well as user-supplied The department_id, department_name,
database objects and structures, column ; ; .
and location_id columns are in the
names, packages and classes, usernames
. hr.departments table.
and roles, program units, and parameter
values. Set the QUERY_REWRITE_ENABLED
. initialization parameter to true.
Note: Some programmatic elements use a
mixture of UPPERCASE and lowercase. Connect as oe user.
Enter these elements as shown. The JRepUtil class implements these
methods.
lowercase Lowercase italic monospace font You can specify the parallel_clause.
italic represents placeholders or variables. Run Uold release.SOL where old._
monospace .
: ; release refers to the release you installed
(fixed-width) . di
Font prior to upgrading.
Conventions in Code Examples
Code examples illustrate SQL, PL/SQL, SQL*Plus, or other command-line
statements. They are displayed in a monospace (fixed-width) font and separated
from normal text as shown in this example:
SELECT username FROM dba_users WHERE username = 'MIGRATE';
The following table describes typographic conventions used in code examples and
provides examples of their use.
Convention Meaning Example
[ 1] Brackets enclose one or more optional DECIMAL (digits [ , precision ])

{

}

items. Do not enter the brackets.

Braces enclose two or more items, one of
which is required. Do not enter the braces.

A vertical bar represents a choice of two
or more options within brackets or braces.
Enter one of the options. Do not enter the
vertical bar.

{ENABLE | DISABLE}

{ENABLE | DISABLE}
[COMPRESS | NOCOMPRESS]



Convention

Meaning

Example

Other notation

Italics

UPPERCASE

lowercase

Horizontal ellipsis points indicate either:

= That we have omitted parts of the
code that are not directly related to
the example

= That you can repeat a portion of the
code

Vertical ellipsis points indicate that we
have omitted several lines of code not
directly related to the example.

You must enter symbols other than
brackets, braces, vertical bars, and ellipsis
points as shown.

Italicized text indicates placeholders or
variables for which you must supply
particular values.

Uppercase typeface indicates elements
supplied by the system. We show these
terms in uppercase in order to distinguish
them from terms you define. Unless terms
appear in brackets, enter them in the
order and with the spelling shown.
However, because these terms are not
case sensitive, you can enter them in
lowercase.

Lowercase typeface indicates
programmatic elements that you supply.
For example, lowercase indicates names
of tables, columns, or files.

Note: Some programmatic elements use a
mixture of UPPERCASE and lowercase.
Enter these elements as shown.

CREATE TABLE ... AS subquery;

SELECT coll, col2, ... ,
employees;

coln FROM

SQL> SELECT NAME FROM VSDATAFILE;

/fsl/dbs/tbs_01.dbf
/fsl/dbs/tbs_02.dbf

/fsl/dbs/thbs_09.dbf
9 rows selected.

acctbal NUMBER (11,2);
acct CONSTANT NUMBER (4) := 3;

CONNECT SYSTEM/system password
DB NAME = database name

SELECT last_name, employee id FROM
employees;

SELECT * FROM USER TABLES;

DROP TABLE hr.employees;

SELECT last_name, employee id FROM
employees;

sglplus hr/hr

CREATE USER mjones IDENTIFIED BY ty3MU9;

xviii



Conventions for Windows Operating Systems
The following table describes conventions for Windows operating systems and

provides examples of their use.

Convention

Meaning

Example

Choose Start >

File and directory
names

C:\>

Special characters

HOME,_NAME

How to start a program.

File and directory names are not case
sensitive. The following special characters
are not allowed: left angle bracket (<),
right angle bracket (>), colon (:), double
quotation marks ("), slash (/), pipe (1),
and dash (-). The special character
backslash (\) is treated as an element
separator, even when it appears in quotes.
If the file name begins with \\, then
Windows assumes it uses the Universal
Naming Convention.

Represents the Windows command
prompt of the current hard disk drive.
The escape character in a command
prompt is the caret (*). Your prompt
reflects the subdirectory in which you are
working. Referred to as the command
prompt in this manual.

The backslash (\) special character is
sometimes required as an escape
character for the double quotation mark
(") special character at the Windows
command prompt. Parentheses and the
single quotation mark (') do not require
an escape character. Refer to your
Windows operating system
documentation for more information on
escape and special characters.

Represents the Oracle home name. The
home name can be up to 16 alphanumeric
characters. The only special character
allowed in the home name is the
underscore.

To start the Database Configuration Assistant,
choose Start > Programs > Oracle - HOME_
NAME > Configuration and Migration Tools >
Database Configuration Assistant.

c:\winnt"\"system32 is the same as
C: \WINNT\SYSTEM32

C:\oracle\oradata>

C:\>exp scott/tiger TABLES=emp
QUERY=\"WHERE job='SALESMAN' and
sal<1600\"

C:\>imp SYSTEM/password FROMUSER=scott
TABLES= (emp, dept)

C:\> net start OracleHOME NAMEINSListener
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Convention

Meaning

Example

ORACLE_HOME
and ORACLE._
BASE

In releases prior to Oracle8i release 8.1.3,
when you installed Oracle components,
all subdirectories were located under a
top level ORACLE_HOME directory. For
Windows NT, the default location was
C:\orant.

This release complies with Optimal
Flexible Architecture (OFA) guidelines.
All subdirectories are not under a top
level ORACLE_HOME directory. There is a
top level directory called ORACLE_BASE
that by defaultis C: \oracle. If you
install the latest Oracle release on a
computer with no other Oracle software
installed, then the default setting for the
first Oracle home directory is
C:\oracle\orann, where nnis the
latest release number. The Oracle home
directory is located directly under
ORACLE_BASE.

All directory path examples in this guide
follow OFA conventions.

Refer to Oracle9i Database Getting Started
for Windows for additional information
about OFA compliances and for
information about installing Oracle
products in non-OFA compliant
directories.

Go to the ORACLE,_BASE\ORACLE.__
HOME\rdbms\admin directory.

Documentation Accessibility

XX

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to

evolve over time, and Oracle Corporation is actively engaged with other

market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,

visit the Oracle Accessibility Program Web site at

http://www.oracle.com/accessibility/



Accessibility of Code Examples in Documentation JAWS, a Windows screen
reader, may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, JAWS may not always read a line of text that
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This
documentation may contain links to Web sites of other companies or organizations
that Oracle Corporation does not own or control. Oracle Corporation neither
evaluates nor makes any representations regarding the accessibility of these Web
sites.
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Overview of Oracle Application Server

Integration Adapter for CICS

This chapter introduces the Oracle Application Server Integration Adapter for CICS.
The Oracle Application Server Integration Adapter for CICS is a plug-in component
of Oracle Application Server ProcessConnect, enabling Oracle Application Server
ProcessConnect to access programs running under CICS on IBM OS/390 or z/OS
series operating systems.

This chapter contains the following sections:

Overview of Application Integration
Overview of CICS and Oracle Application Server Integration Adapter for CICS

Integrating Oracle Application Server ProcessConnect with the Adapter for
CICS

Modeling the CICS Adapter Using Oracle Studio

Overview of Oracle Application Server Integration Adapter for CICS 1-1



Overview of Application Integration

Overview of Application Integration

When business applications need to communicate with each other, the output from
one application is not always understandable by the other application. Application
adapters enable different applications to interoperate.

Adapters for application integration address a mismatch between the integrating
interface of a source or target application and the integration infrastructure, such as
Oracle Application Server ProcessConnect. Simple adapters only exchange data
using an API, but complex adapters can also do transformations, as well as deal
with exception conditions. Therefore, adapters are a combination of modeling tools
and runtime software that act as "glue" to link applications, considered as sources or
targets (or both), to the integration infrastructure that transports, translates,
transforms, and routes data between systems. On the one hand, an adapter deals
with a group of touchpoints (one or more entry/exit points, collectively an
interface) for a source or target; on the other hand, an adapter links to the
integration infrastructure. This means that adapters generally have two interfaces -
one that is native to the source or target application and the other that is native to
the integrating infrastructure. Adapters perform a variety of key tasks, including
recognizing events, collecting and transforming data, and exchanging data with the
integration infrastructure. They also handle exception conditions, and can often
dynamically (or with minor reconfiguration changes) accommodate new revisions
of back-end applications.

Each task performed by the adapter is defined as an interaction. Interactions that
are initiated by the source or target application are referred to as inbound
interactions. Interactions that are initiated by the integrating infrastructure are
referred to as outbound interactions.

Overview of CICS and Oracle Application Server Integration Adapter for

CICS

The Oracle Application Server Integration Adapter for CICS is a plug-in component
of Oracle Application Server ProcessConnect.

The Oracle Application Server Integration Adapter for CICS models programs
running under Customer Information Control System (CICS). The adapter is native
to the OS/390, providing direct access that results in improved performance.
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CICS

CICS is a family of application servers that provides industrial-strength, online
transaction management and connectivity for mission-critical applications on IBM
mainframe systems.

The application components in CICS are executable programs called transactions.
These programs are typically written in COBOL but may possibly be written in
other languages, such as PL/I, C and even Java. Each Oracle Application Server
Integration Adapter for CICS outbound interaction is mapped to a specific
program.

The Oracle Application Server Integration Adapter for CICS uses COMMAREA
transactions to communicate with clients, using a communication buffer described
in the transaction program (such as a COBOL copybook). There is an input
structure and an output structure (each with a limit of 32Kb). In many cases,
transactions are written so that the input structure prefixes the output structure.

The Oracle Application Server Integration Adapter for CICS uses EXCI (EXternal
Call Interface) to invoke CICS transactions from tasks running within the OS/390
system. EXClI is efficient since it uses cross-memory mechanisms.

The Oracle Application Server Integration Adapter for CICS captures and maintains
a metadata schema for CICS by importing COBOL copybooks and transforming
them into mapping definitions for Oracle Connect for CICS on the OS/390 machine
and by associating the data structures with specific physical files.

The Oracle Application Server Integration Adapter for CICS uses an enterprise
application integration (EAI) model. Users of a requesting application can model
the interactions that they want implemented, specifying what each interaction does,
when it occurs and the inputs and outputs expected for each interaction. Moreover,
the Oracle Application Server Integration Adapter for CICS maps data structures,
facilitating access to CICS transactions from within Oracle Application Server
ProcessConnect.

Architecture of the Oracle Application Server Integration Adapter for CICS

The Oracle Application Server Integration Adapter for CICS includes the following
components:

s The CICS adapter, which resides in Oracle Application Server ProcessConnect
s Oracle Connect for CICS, which resides on the OS/390 machine

» A GUI-based configuration tool, called Oracle Studio for Legacy Adapters,
which resides on a Windows platform.
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Note: Throughout this manual Oracle Studio for Legacy Adapters
is referred to as Oracle Studio.

The components of the Oracle Application Server Integration Adapter for CICS
interact with each other, as shown in Figure 1-1 on page 1-4.

Figure 1-1 Architecture of the Oracle Application Server Integration Adapter for CICS

Oracle Application Server IBM OS/390 Platform
ProcessConnect
Platform Oracle Connect for
cics
Oracle Application
Server
ProcessConnect
cics Daemon BCIES d
Adanter | € | Listener | €| Backen
p —p | Adapter
| A
EXCI
Oracle Studio for CICS Region
Legacy Adapters Platform
COMMAREA
Oracle
Studio

The CICS adapter enables communication with Oracle Connect for CICS on the
0S/390 platform.

Oracle Connect for CICS is comprised of two main components:

= Daemon (alistener) - Responsible for managing and allocating server processes
for client requests coming from Oracle Application Server ProcessConnect.
Server processes can be started per client or kept in a pool for reuse. The
daemon resides in a single address space and is executed as a started task.

See Also: "Troubleshooting the Daemon" on page 6-4 and

Appendix C, "Daemon Configuration Settings" for details about the
daemon
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= CICS backend adapter - Provides the interaction definitions and input and
output record schemas required to access a program running under CICS

Oracle Studio is used to model the adapter interactions and manage the back-end
component.

Inbound Interactions

CICS does not have a built-in model for inbound transactions. Applications that run
under CICS can interact with Oracle Application Server ProcessConnect by sending
it a native event. The native event is sent to a queue running on the mainframe and
the adapter subscribes to that queue for inbound event handling. Typically, each
application associated with Oracle Connect for CICS will subscribe to a dedicated
queue.

The Oracle Application Server Integration Adapter for CICS provides the following
ways for an CICS transaction to send an inbound interaction:

= Invoking a special CICS transaction

= Using an API from a COBOL program

Integrating Oracle Application Server ProcessConnect with the Adapter
for CICS

Oracle Application Server Integration Adapter for CICS is fully integrated with
Oracle Application Server ProcessConnect, both during the modeling and runtime
phases.

The Modeling Phase

The Oracle Application Server Integration Adapter for CICS is integrated with
Oracle Application Server ProcessConnect as follows:

= Modeling the Oracle Application Server Integration Adapter for CICS is
performed using Oracle Studio. This step includes modeling inbound and
outbound interactions as required.

See Also: "Modeling the CICS Adapter Using Oracle Studio” on
page 1-6

= After the Oracle Application Server Integration Adapter for CICS has been
modeled in Oracle Studio, the integration between the adapter and the
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application in Oracle Application Server ProcessConnect is modeled. Within
Oracle Application Server ProcessConnect you define a delivery channel for the
adapter and then add interactions from the list modeled using Oracle Studio.

See Also: Oracle Application Server ProcessConnect User’s Guide

Runtime

At runtime, the interactions specified in the Oracle Application Server
ProcessConnect application are executed.

For outbound interactions, the interactions for the Oracle Application Server
Integration Adapter for CICS are handled by Oracle Connect for CICS on the
0S5/390 machine. The CICS transaction specified in the interaction is executed and
any output are returned to Oracle Application Server ProcessConnect.

For inbound interactions, the interactions are initiated on the OS/390 machine and
sent to Oracle Application Server ProcessConnect.

Modeling the CICS Adapter Using Oracle Studio

Oracle Studio is used to model and manage the Oracle Application Server
Integration Adapter for CICS.

Oracle Studio uses perspectives enabling you to focus specific information
necessary to model the Oracle Application Server Integration Adapter for CICS.

The following perspectives are available:
= The Configuration Perspective

»  The Metadata Perspective

»  The Metadata Import Perspective

s The Runtime Manager Perspective

The Configuration Perspective

Use the Configuration perspective to define access to CICS programs on an IBM
0OS/390 machine.
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The Metadata Perspective

Use the Metadata perspective to model the Oracle Application Server Integration
Adapter for CICS interactions and the expected inputs and output.

The Metadata Import Perspective

Use the Metadata Import perspective to import information in COBOL programs
and copybooks for use by Oracle Connect for CICS to create outbound interactions.

The Runtime Manager Perspective

Use the Runtime Manager perspective to troubleshoot Oracle Connect for CICS by
monitoring daemon activity on the OS/390 machine.
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Installing the Oracle Application Server
Integration Adapter for CICS

This chapter explains how to install Oracle Connect for CICS and Oracle Studio
software from the distribution CD-ROM.

Note: In addition to the installation procedures described in this
chapter, the CICS adapter component of the Oracle Application
Server Integration Adapter for CICS software must be installed
with Oracle Application Server ProcessConnect. Installing the
CICS adapter component is described in the Oracle Application
Server ProcessConnect Installation Guide.

This chapter includes the following sections:

= Before You Begin

» Installing Oracle Connect for CICS on an OS/390 Platform
= Updating Oracle Connect with CICS

» Installing Oracle Studio

= Configuring Oracle Connect for CICS

= Securing Access to Oracle Connect for CICS
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Before You Begin

Confirm that you have met all hardware and software requirements. Refer to the
following sections:

= Determining the Hardware and Software Requirements for the OS/390

= Determining the Hardware and Software Requirements for Windows

Determining the Hardware and Software Requirements for the 0S/390

This section describes the following requirements for installing Oracle Connect for
CICS:

= Hardware Requirements

= Software Requirements

Hardware Requirements

The following table summarizes the hardware requirements for Oracle Connect for
CICS.

Hardware Component  Requirements

Processor IBM S/390 machine

Memory The minimum requirement is 1MB per user. The actual memory
requirement depends on the size of the CICS COMMAREA
used.

CD-ROM Drive An internal or external CD-ROM drive

Disk Space (3380 and 150 cylinders
3390 disks)

Software Requirements

The system software configuration described in this section is supported by Oracle
Corporation as long as the underlying system software products are supported by
their respective vendors. Verify the latest support status with your system software
vendors.

The following table summarizes the software requirements for Oracle Connect for
CICS.
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Software Component Requirements
Operating System IBM OS/390 V2R5 and up or z/OS series

CICS TP Monitor V4R1 and up (recommended to use CICS V6R1 and up)

CICS EXCI support must be installed and IRCSTRT=YES must
be specified in the CICS initialization parameters, so that the IRC
(Inter Region Communication) starts.

You can also set the IRC to open by issuing the following
command: CEMT SET IRC OPEN. Also the IBM group
DFHS$EXCI (or an equivalent user-defined group) must be
installed in the CICS region - using the CEDA RDO facility.

Oracle Application Oracle Application Server 10g (9.0.4)

Server ProcessConnect - .
Oracle Application Server ProcessConnect can reside on any

supported platform

Determining the Hardware and Software Requirements for Windows

This section describes the following requirements for installing Oracle Studio:
» Hardware Requirements

= Software Requirements

Hardware Requirements
The following table summarizes the hardware requirements for Oracle Studio.

Hardware Component  Requirements

Processor An Intel or 100% compatible personal computer (PC), based on a
Pentium processor

Memory 128 MB of RAM

CD-ROM Drive An internal or external CD-ROM drive

Disk Space 75MB of free disk space

Software Requirements

The system software configuration described in this section is supported by Oracle
Corporation as long as the underlying system software products are supported by
their respective vendors. Verify the latest support status with your system software
vendors.
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The following table summarizes the software requirements for Oracle Studio.

Software Component Requirements

Operating System Microsoft Windows NT Server Version 4.0 with service pack 5 or
higher, Microsoft Windows 2000 with service pack 2 or higher, or
Microsoft Windows XP

Microsoft Network transport protocol software, TCP/IP, included with

Microsoft Windows

Installing Oracle Connect for CICS on an 0S/390 Platform

Note: If you have an Oracle Connect Legacy Adapter already
installed on the OS/390 machine, follow the instructions described
in "Updating Oracle Connect with CICS" on page 2-15.

The other legacy adapters that run on an OS/390 machine are:
= Oracle Application Server Integration Adapter for IMS/DB
= Oracle Application Server Integration Adapter for IMS/TM
= Oracle Application Server Integration Adapter for VSAM

This section explains how to install Oracle Connect for CICS software from the
distribution CD-ROM. This section includes the following:

» Installation Worksheet

= Preinstallation Instructions

= Installing the Kit on the Mainframe
» Installation Instructions

s Postinstallation Instructions

Installation Worksheet

Verify that you have all the information detailed in the following installation
worksheets, so you can refer to it during the configuration process.
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Table 2-1 Preinstallation Information

Topic Required Information Default Comment

General Operating system - 0S/390 V2R5 and up (including z/OS)

- Disk space - 150 cylinders

- Memory - Minimum 1MB per user

- Installation high-level OCL904 -

qualifier

- Volume - -

- Unit 3390 SMS only: unit where SMS resides.

- Output class A -

- JCL job card - An optional card (up to 6 lines) to replace
the prefix job (entered as it will appear in
the job)

- ISPF load library name ISP.SISPLOAD -

CICS CICS EXCI load library name CICS.CICS.SDFHEXCL -

Table 2-2 Required Permissions

Permission

Permission to define an APF-authorized library

Permission to write to an active proclib (such as user.proclib)
Permission to read the CICS EXCI library

Permission to update the security manager (such as RACF)

Optionally, permission to specify an output class for Oracle Connect for CICS output
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Table 2-3 Installation Checklist

Step

Comment/Outputs

tso profile prefix
Allocate dataset: {HLQ}.TRANSMIT.KIT
Allocate dataset: {HLQ}.TRANSMIT.LOAD

FTP files to OS/390 (or z/OS)
RECEIVE INDSNAME('{HLQ}.TRANSMIT.KIT")

da('{HLQ}.TRANSMIT.LIB') UNIT(unit) VOLUME(volume)

EX {HLQ}.TRANSMIT.LIB(PREPARE)

EX {HLQ}.BUILDKIT.SRC(NAVINST)

Ensures that the user name is not used as part of
the dataset name allocated in the next steps

130 tracks (3390), format=FB, record length=80,
block size=3120

420 tracks (3390), format=FB, record length=80,
block size=3120

FTP using binary mode

Successful MAXCCis 0,4 or 8
BUILDKIT.SRC and BUILDKIT.LOAD created

Successful MAXCC is 0 or 4

Preinstallation Instructions

Before starting the installation, make sure that you have the following information

available:

= The output class for the installation output if you do not want to use the default

value, which is A

= If you use SMS to manage all datasets (you cannot provide unit and volume
information), the unit where SMS resides

Before starting the installation, make sure that you have the following permissions:

= Permission to define an APF-authorized library

= Permission to write to an active proclib (such as user.proclib)

= Permission to read the CICS EXCI library

= Permission to update the security manager (such as RACF)

Note: Optionally, make sure that you have permission to specify
an output class for Oracle Connect for CICS output. Assigning a
device which is set on HOLD prevents the loss of log information
when Oracle Connect for CICS started tasks finish.
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Oracle Connect for CICS software for the IBM OS/390 machine is contained in the
following datasets:

OCLS04 .TRANSMIT.KIT

OCLS04 .TRANSMIT.LOAD

These datasets are provided on a CD-ROM in the directory oracle_Connect\CICS_
Legacy_Adapter.

Installing the Kit on the Mainframe

1.

On the mainframe, run the following command:

tso profile noprefix

The user name will not be used as part of the dataset name. On some systems
this is the default.

On the mainframe, allocate datasets with the following space for each of these
files:

m OCL904.TRANSMIT.KIT = 130 tracks (3380 and 3390 disks)
s OCL904.TRANSMIT.LOAD = 420 tracks (3380 and 3390 disks)
For each dataset: RECFM=FB and LRECL=80. The block size is 3120.

Using FTP, copy OCL904 . TRANSMIT.KIT and OCL904 . TRANSMIT.LOAD in
binary mode from the installation CD to the mainframe. You can replace the
OCL904 high-level qualifier to any qualifier you want.

Installation Instructions
Complete the following steps to install Oracle Connect for CICS:

1.

From within TSO, run the following command at the TSO prompt:
RECEIVE INDSNAME ('nnn.TRANSMIT.KIT')
where nnn represents the high-level qualifier you want to assign for the Oracle

Connect for CICS installation. Assign the high-level qualifier you specified in
step 7 of the preinstallation. The default value is 0OCL904.
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Note: You can use more than one high-level qualifier (such as
ACME.DEV.OCL904) with the following conditions:

= The total length must be less than or equal to twenty characters

s The words "transmit" and "buildkit" cannot be used as
high-level qualifiers

2. Enter the following when prompted for the restore parameters:

da('nnn.TRANSMIT.LIB')

[UNIT (unit) VOLUME (volume) ]

This extracts the nnn. TRANSMIT . LIB library from the nnn. TRANSMIT.KIT
kit to the specified unit and volume. If a unit and volume are not specified the
library is extracted to the current unit and volume.

3. Execute the PREPARE member of the nn. TRANSMIT . LIB library:

ex PREPARE

Follow the instructions in the Response column in Table 2—4 for each entry in

the Screen column.

Table 2-4 Installation Prepare Job Prompts and Responses

Screen

Response

DO YOU WANT TO USE SMS MANAGED
STORAGE FOR THIS INSTALLATION Y/N [N] :

ENTER THE STORCLASS FOR INSTALLATION
TEMP DATASETS [ ] :

ENTER THE UNIT NAME FOR INSTALLATION
TEMP DATASETS [3390] :

ENTER THE VOLUME NAME FOR
INSTALLATION TEMP DATASETS :

ENTER THE OUTPUT CLASS FOR
INSTALLATION OUTPUT [A] :

If you want to manage the storage using SMS, answer Y,
otherwise answer N.

This prompt is displayed only if SMS is used to manage the
installation (you answered Y to the first prompt).

Enter the storage class

If a storage class is not specified, enter the unit name for
temporary datasets used during the installation procedure

This prompt is displayed only if SMS is not used to manage
the installation (you answered N to the first prompt).

The volume name for temporary datasets used during the
installation procedure

Enter the output class only if you do not want the default
class used (the default is A)
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Table 2-4 (Cont.) Installation Prepare Job Prompts and Responses

Screen

Response

DO YOU WANT TO USE THE DEFAULT JOB
CARD Y/N [Y]

DO YOU WANT TO PERFORM A MANUAL
(M) OR AUTOMATIC (A) INSTALLATION [A] :

PLEASE REVIEW AND SUBMIT FOR
EXECUTION THE
HLQ.TRANSMIT.LIB(INSTJO)

A job card is displayed. If you want to use a replacement
card, it must be entered as it will appear in the job. You can
enter up to six lines. Enter a blank line to end input.

If you do not enter a card, the Oracle Connect for CICS
default card is used.

If you want to review the JCL used to install Oracle Connect
for CICS, before it is submitted, respond M for a manual
installation.

This prompt is displayed only if a manual installation is
requested (you answered M to the previous prompt).

The following libraries are generated:

nnn.BUILDKIT.LOAD
nnn.BUILDKIT.SRC
nnn.BUILDKIT.GENDEMO

Where nnn is the high-level qualifiers you assigned in step 1.

4. Inthe nnn.BUILDKIT. SRC library, execute the NAVINST member:

ex NAVINST

Follow the instructions in the Response column in Table 2-5 for each entry in

the Screen column.
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Table 2-5 Installation Prompts and Responses

Screen

Response

DO YOU WANT TO USE SMS MANAGED
STORAGE FOR THIS INSTALLATION Y/N [N] :

THE SOFTWARE WILL BE INSTALLED UNDER
THE HIGH LEVEL QUALIFIER THAT YOU
WILL CHOOSE.

ENTER THE HIGH LEVEL QUALIFIER
['QUALIFIER] :

ENTER THE STORCLASS FOR TEMP DATASETS
[STORCLASS'] :

ENTER THE UNIT NAME FOR INSTALLATION
TEMP DATASETS [3390] :

ENTER THE VOLUME NAME FOR
INSTALLATION TEMP DATASETS :

PLEASE CONFIRM (YES/NO/QUIT) [YES] :

ENTER THE OUTPUT CLASS FOR
INSTALLATION OUTPUT [A] :

DO YOU WANT TO USE THE DEFAULT JOB
CARD Y/N[Y]

If you want to manage the storage using SMS, answer Y,
otherwise answer N.

The high-level qualifier for the installation (referred to as
INSTROOT throughout this guide)

You can use more than one high-level qualifier (such as
ACME.DEV.VAL10). The total length must be less than or
equal to twenty characters. The qualifiers can be the same
as the ones used for the installation (step 1).

The words "transmit" and "buildkit" cannot be used as
high-level qualifiers.

This prompt is displayed only if SMS is used to manage the
installation (you answered Y to the first prompt).

Enter the storage class

The unit name for temporary datasets used during the
installation procedure.

This prompt is displayed only if SMS is not used to manage
the installation (you answered N to the first prompt).

The volume name for temporary datasets used during the
installation procedure

Confirm the entered details

Enter the output class for Oracle Connect for CICS output.
Assigning a device which is set on HOLD prevents the loss
of log information when the Oracle Connect for CICS
started tasks finish (the default is A).

A job card is displayed. If you want to use a replacement
card, it must be entered as it will appear in the job. You can
enter up to six lines. Enter a blank line to end input.

If you do not enter a card, the Oracle Connect for CICS
default card is used.
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Table 2-5 (Cont.) Installation Prompts and Responses

Screen Response

ADDING AND UPDATING ORACLE In order to manage Oracle Connect on this machine from
CONNECT FOR CICS CONFIGURATION ON Oracle Studio, you need to enter a user account of a user
THIS MACHINE, FROM A REMOTE ORACLE who will have administrative authorization, or press Enter
ADMINISTRATION CONSOLE, CAN ONLY BE  to enable any user to administer Oracle Connect on this
DONE BY SOMEONE DEFINED AS AN machine. The administrative rights can be changed from
ADMINISTRATOR FOR ORACLE CONNECT within Oracle Studio after the installation.

ON THIS MACHINE.

ENTER A VALID USER NAME FOR AN
ORACLE CONNECT ADMINISTRATOR [ALL]:

DO YOU WANT TO PERFORM A MANUAL (M) If you want to review the JCL used to install Oracle
OR AUTOMATIC (A) INSTALLATION [A] : Connect for CICS, before it is submitted, respond M for a
manual installation.

PLEASE REVIEW AND SUBMIT FOR This prompt is displayed only if a manual installation is
EXECUTION THE DSN1 (INSTJBOR) requested (you answered M to the previous prompt).

DSNI1 is the dataset name where INSTJBOR is located.

5. Inthe nnn.BUILDKIT. SRC library, execute the CICS member:

ex CICS

Follow the instructions in the Response column in Table 26 for each entry in
the Screen column.

Table 2-6 CICS Adapter-Specific Installation Prompts and Responses

Screen Response

ENTER THE CICS EXCI LOAD LIBRARY NAME Enter the CICS EXCI load library name only if you do not
[CICSTS13.CICS.SDFHEXCI] : want the default

PLEASE CONFIRM (YES/NO/QUIT) [YES] : Confirm the entered details

ENTER THE ISPF LOAD LIBRARY NAME Enter the ISPF load library name only if you do not want the
[ISP.SISPLOAD] : default
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Table 2-6 (Cont.) CICS Adapter-Specific Installation Prompts and Responses

Screen Response

PLEASE CONFIRM (YES/NO/QUIT) [YES] : Confirm the entered details

ENTER THE OUTPUT CLASS FOR Enter the output class for Oracle Connect for CICS output.
INSTALLATION OUTPUT [A] : Assigning a device which is set on HOLD prevents the loss of

log information when the Oracle Connect for CICS started
tasks finish (the defaultis A).

DO YOU WANT TO USE THE DEFAULT JOB A job card is displayed. If you want to use a replacement

CARD Y/N [Y]

card, it must be entered as it will appear in the job. You can
enter up to six lines. Enter a blank line to end input.

If you do not enter a card, the Oracle Connect for CICS
default card is used.

The installation is completed. All JCL jobs and REXX procedures are written to the
INSTROOT.USERLIB library. INSTROOT is the high-level qualifier for the
installation.

Postinstallation Instructions

The following postinstallation tasks must be done to work with Oracle Connect for
CICS:

s General Postinstallation Procedures
= Starting the Daemon

s Setting Up Oracle Connect for CICS for Reentrancy

General Postinstallation Procedures
Perform the following procedures after completing the installation, to configure
Oracle Connect for CICS.

= Allocate a dataset for INSTROOT . DEF . BRANDBIN, using 1 track and with
RECFM=VB and LRECL=256. The block size is 6233.

INSTROQT is the high-level qualifier where Oracle Connect for CICS is
installed.

Using FTP, copy the BRANDBIN file, in binary mode, from the
Oracle Connect\CICS Legacy Adapter directory in the installation CD to the
mainframe, to INSTROOT.DEF . BRANDBIN.

= Define the LoaDAUT library as an APF-authorized library
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Note: To define a DSN as APF-authorized, in the SDSF screen
enter the command:

"/setprog apf,add,dsn=INSTROOT.loadaut,volume=vol002"

where vol002 is the volume where you installed Oracle Connect for
CICS and INSTROOT is the high-level qualifier where Oracle
Connect for CICS is installed.

If the site uses SMS, when defining APF-authorization in the SDSF
screen enter the command:

"/setprog apf,add,dsn=INSTROOT.loadaut, SMS"

Make sure that the library is APF-authorized, even after an IPL
(reboot) of the machine.

Move the NSTROOT.USERLIB (ATTDAEMN) and
NSTROOT.USERLIB (ATTSRVR) members to any active proclib (such as
user.proclib). ATTDAEMN and ATTSRVR are run as started tasks.

If you decide to change the name of the ATTSRVR member when you move it to
a general high-level qualifier, change the name specified in the StartupScript
parameter in the daemon configuration to the new name:

s  Run INSTROOT.USERLIB (NAVCMD) and enter EDIT DAEMON IRPCDINI
at the prompt.

= Change the startupScript parameter from ATTSRVR to the new name for the
server:

<Workspace name="Navigator"
startupScript="NEW_NAME"
serverMode="reusable"
L />
» Exit and save the change.

Change the following line in the ATTDAEMN script to include the IP address and
port of the OS/390 machine.

For example, before:

// PARM='-B START IRPCDINI'
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After:

// PARM='-B -L ip_address:2252 START IRPCDINI'

where ip_address is ip address of the machine, 2552 is the default port for
starting the daemon and IRPCDINT is the default daemon configuration.

= In the security manager, define ATTDAEMN and ATTSRVR with a started task
class and a general profile that enables access to an Open OS/390 segment (that
defines access to TCP/IP OA sockets)

»  The installation includes a PS, INSTROOT . DEF . GBLPARMS, that contains global
environment information. This PS is read at startup and the correct software
version is used, based on the details provided in the startup task.

If you change the location of this member, you must also change the relevant
cards in the following jobs to the new locations:

= ATTSRVR - located in an active proclib (such as user . proclib)
= ATTDAEMN - located in an active proclib (such as user . proclib)
= NAVSQL - located in TNSTROOT.USERLIB

s The input during the installation procedure is written to
nnn.BUILDKIT.SRC (PARS). You can use this file to provide the same inputs
if you rerun the installation, where nnn is the high-level qualifier you assign for
the installation.

= For information about specifying Oracle Connect for CICS as the service using
port 2552 in the TCP/IP network services file, consult TCP/IP documentation.

Starting the Daemon

Activate INSTROOT.USERLIB (ATTDAEMN) as a started task to invoke the daemon.
For example, in the SDSF screen enter the following:

'/s ATTDAEMN'

INSTROOT is the high-level qualifier where Oracle Connect for CICS is installed.

To submit the daemon as a job, uncomment the first two lines of the ATTDAEMN JCL,
change the PARM line as described above, and run the job using the sub command.
The ATTDAEMN JCL is similar to the following:

//*ATTDAEMN JOB 'RR','TTT',MSGLEVEL=(1,1),CLASS=A,
//* MSGCLASS=A,NOTIFY=&SYSUID, REGION=8M
//STEP1 EXEC PGM=IRPCD,
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// PARM='-B START IRPCDINI'

//* PARM='-B -L :8883 START'

//STEPLIB DD DSN=INSTROOT.LOADAUT, DISP=SHR
//SYSPRINT DD SYSOUT=A

//GBLPARMS DD DSN=INSTROOT.DEF .GBLPARMS, DISP=SHR

// EXEC PGM=IRPCD,COND=((1,EQ,STEP1), (2,EQ,STEP1)),
// PARM='-KATTDAEMN START ''INSTROOT.DEF.IRPCDINI'''
//STEPLIB DD DSN=INSTROOT.LOADAUT, DISP=SHR
//SYSPRINT DD SYSOUT=A

//GBLPARMS DD DSN=INSTROOT.DEF .GBLPARMS, DISP=SHR
//SYSDUMP DD DUMMY

Setting Up Oracle Connect for CICS for Reentrancy

To set up Oracle Connect for CICS to be reentrant, move INSTROOT. LOAD to the
Link Pack Area (LPA).

INSTROOT s the high-level qualifier where Oracle Connect for CICS is installed.

Using the LPA reduces real storage usage (because everyone shares the LPA copy)
and fetch time.

Note: If you intend using impersonation, so that you can runin a
security context that is different than the context of the process
that owns the server, do the following:

s Place the INSTROOT.LOAD (ATYSVCW) member in an
APF-authorized library outside the LPA.

= Change the ATTSRVR member (located in the active proclib),
by adding the following to the STEPLIB list:

// DD DSN=apf_ library,DISP=SHR

Where apf_Ilibrary isthe APF-authorized library outside the
LPA where the ATYSCVW member was moved.

Updating Oracle Connect with CICS

Verify that you have all the information detailed in the following installation
worksheets, so you can refer to it during the configuration process.
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Table 2-7 Preinstallation Information

Topic Required Information Default Comment

CICS CICS EXCI load library name CICS.CICS.SDFHEXCL -

Table 2-8 Required Permissions

Permission

Permission to read the CICS EXCI library

In the nnn . BUILDKIT. SRC library, execute the CUSTOCL member:

ex CUSTOCL

Follow the instructions in the Response column in Table 2-9 for each entry in the
Screen column.

Table 2-9 CICS Adapter Installation Prompts and Responses

Screen Response

DO YOU WANT ORACLE CONNECT FOR Answer YES to this prompt if you have Oracle Connect for
LEGACY ADAPTER TO WORK WITH IMS/DB  IMS/DB already installed.
(YES/NO) [YES] :

ENTER DBD LIBRARY NAME [IMS.DBDLIB] :  If you responded YES to working with IMS/DB, enter the
library where database definition (DBD) files are located.

ENTER PSB LIBRARY NAME [IMS.PSBLIB] : If you responded YES to working with IMS/DB, enter the
library where Program Specification Blocks (PSBs) are
located.

ENTER YOUR PSB NAME [HOSPPSB] : If you responded YES to working with IMS/DB, enter the
name of the PSB file to use.

PLEASE CONFIRM (YES/NO/QUIT) [YES] : If you responded YES to working with IMS/DB, confirm the
entered details.

DO YOU WANT ORACLE CONNECT FOR If you want to access IMS/DB data under CICS, using the

LEGACY ADAPTER TO WORK WITH IMS/DB  Oracle Application Server Integration Adapter for IMS/DB,

UNDER CICS (YES/NO) [NOJ : respond YES.

ENTER THE CICS EXCI LOAD LIBRARY NAME If you responded YES to working with IMS/DB under CICS,

[CICSTS13.CICS.SDFHEXCI] : enter the CICS EXCI load library name only if you do not
want the default.

PLEASE CONFIRM (YES/NO/QUIT) [YES] : If you responded YES to working with IMS/DB under CICS,

confirm the entered details.
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Table 2-9 (Cont.) CICS Adapter Installation Prompts and Responses

Screen Response

DO YOU WANT ORACLE CONNECT FOR Answer YES to this prompt
LEGACY ADAPTER TO WORK WITH CICS
APP ADAPTER (YES/NO) [YES] :

ENTER THE CICS EXCI LOAD LIBRARY NAME Enter the CICS EXCI load library name only if you do not

[CICSTS13.CICS.SDFHEXCI] : want the default.

PLEASE CONFIRM (YES/NO/QUIT) [YES] : Confirm the entered details

THE VSAM DRIVER IS INSTALLED Answer YES to this prompt if you have Oracle Connect for
AUTOMATICALLY. DO YOU ALSO WANT VSAM already installed and you want to access VSAM data

ORACLE CONNECT FOR LEGACY ADAPTER  under CICS.
TO WORK WITH VSAM UNDER CICS
(YES/NO)  [NOJ:

ENTER THE CICS EXCI LOAD LIBRARY NAME If you responded YES to working with VSAM under CICS,

[CICSTS13.CICS.SDFHEXCI] : enter the CICS EXCI load library name only if you do not
want the default.

PLEASE CONFIRM (YES/NO/QUIT) [YES] : If you responded YES to working with VSAM under CICS,
confirm the entered details.

ENTER THE ISPF LOAD LIBRARY NAME Enter the ISPF load library name only if you do not want the

[ISP.SISPLOAD] : default.

PLEASE CONFIRM (YES/NO/QUIT) [YES] : Confirm the entered details

ENTER THE OUTPUT CLASS FOR Enter the output class for Oracle Connect output. Assigning

INSTALLATION OUTPUT [A] : a device which is set on HOLD prevents the loss of log
information when the Oracle Connect started tasks finish
(the defaultis A).

DO YOU WANT TO USE THE DEFAULT JOB A job card is displayed. If you want to use a replacement

CARD Y/N [Y] card, it must be entered as it will appear in the job. You can

enter up to six lines. Enter a blank line to end input.

If you do not enter a card, the Oracle Connect default card is
used.

The installation is completed. All JCL jobs and REXX procedures are written to the
INSTROOT.USERLIB library. INSTROOT is the high-level qualifier for the
installation.

After completing the installation, perform postinstallation tasks, as described in
"Postinstallation Instructions” on page 2-12, as required.
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Installing Oracle Studio

Note: If you have Oracle Studio already installed because you are
also using another legacy adapter, you do not need to reinstall it.

The other legacy adapters are:

= Oracle Application Server Integration Adapter for IMS/DB
= Oracle Application Server Integration Adapter for IMS/TM
= Oracle Application Server Integration Adapter for Tuxedo

= Oracle Application Server Integration Adapter for VSAM

This section explains how to install Oracle Studio software from the distribution
CD-ROM.

Installing Oracle Studio from the CD-ROM

Assuming that the CD-ROM drive is D:, the installation file is located in the
D:\Oracle_Studio directory. Install the software from the CD-ROM by running
the self-extracting executable installation file, 0SL904-win32 . exe, either using the
Run option in the Windows Start menu or through Windows Explorer.

Caution: If you are installing Oracle Studio on a Windows XP
machine, you cannot specify a logical drive as the Destination
folder for the installation.

Configuring Oracle Connect for CICS

All modeling of Oracle Connect for CICS is performed using Oracle Studio. To use
Oracle Studio you first configure it to enable access to the IBM OS/390 machine.

Note: The following tasks assume you have permission to access
the IBM OS/390 machine under CICS and that the Oracle Connect
for CICS daemon is running on this machine.

Check with the system administrator to ensure these requirements
are fulfilled.
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Task: Setting Up the IBM 0S/390 Machine

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio. Oracle Studio opens, displaying
the Configuration perspective.

”"‘Eonﬁguration - Oracle Studio for Legacy Adapters

File Edit Mavigate Search ‘Window Help

EREETR

ﬁ ﬁ Configuration Explarer ® X l
g || & 00 Machines Welcome to Oracle Studio for Legacy Adapters
Oracle Studia For Legacy Adapters is an integrated GUI-based environmeant =

For managing Oracle Connect For Legacy Adapters at a site.

Fram the Oracle Skudio for Legacy Adapters console you can set up and manage Oracle
Connect legacy adapters on any machine where Oracle Connect For Legacy Adapters is
installed.

@ Configuring Oracle Connect for Legacy Adapters
IManaging an Orache Connect for Legacy Adapkers machine is accomplished within
Cracle Studio For Legacy Adapters using perspectives, A perspective is a collection
of panes that present a specific view of Oracle Connect for Legacy Adapters resources
and the ability to edit these resources, & logical Flow between perspectives is
provided, For example: Adding an adapter {using the Configuration perspective) leads
directly to importing metadata {using the Import Metadata perspective).

@ Oracle Studio for Legacy Adapters
COracle Studio For Legacy Adapters opens with the Configuration perspective
displawed. Right-click the Machines node to add an Oracle Connect for Legacy Adapters
machine,

Once a machine has been defined to Oracle Studio for Legacy Adapters, you can
5] Properties = L % configure the Following, using the Configuration perspective:
=T

Propert | ‘alue Bindings - The NaY binding configuration includes information about the
adapters that can be accessed using Oracle Application Server 10g ProcessConneck,

Daemons - & daemon is responsible For cient/server communications, allocating
a server process for a client request,

Users - & user profile controls access to machines and applications
using user name and password pairs, instead of the user having to provide this
information when accessing the resource. ol

2. Right-click Machines in the Configuration Explorer and choose Add Machine
from the popup menu.

The Add Machine window appears.
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Add machine

Add machine <
Define new machine

—Machine

Phiysical address: Erowse |

¥ Default port: |
[~ Marne: |

r—Connection

User name: |

Password: |

Confirm password: I

r Anonyrmaous conneckion

[~ Connect via MAT/FixedNAT

Einish I Cancel I

3. In the Add Machine window, uncheck the Default port check box and enter
2552 as the port number.

4. Enter the name of the machine you want to connect to, or click Browse to
choose the machine from the list of machines that is displayed.

5. Specify the username and password of the user who was specified as the
administrator when Oracle Connect for CICS was installed.

Note: Checking the Anonymous connection checkbox enables
anyone having access to the machine to be an administrator, if this
was defined for the machine.

6. Click Finish. The machine is displayed in the Configuration Explorer.
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{ie} Configuration - Oracle Studio for Legacy Adapters

File Edit Mavigate Search ‘Window Help

x welcome X l

- Users

Welcome to Oracle Studio for Legacy Adapters

Oracle Studio for Legacy Adapters is an integrated GUI-based environment
For managing Oracle Conmect For Legacy Adapters at a site.

Fram the Oracle Skudio for Legacy Adapters console you can set up and manage Oracle
Connect legacy adapters on any machine where Oracle Connect For Legacy Adapters is
installed.

@ Configuring Oracle Connect for Legacy Adapters
IManaging an Orache Connect for Legacy Adapkers machine is accomplished within
Cracle Studio For Legacy Adapters using perspectives, A perspective is a collection
of panes that present a specific view of Oracle Connect for Legacy Adapters resources
and the ability to edit these resources, & logical Flow between perspectives is
provided, For example: Adding an adapter {using the Configuration perspective) leads
directly to importing metadata {using the Import Metadata perspective).

@ Oracle Studio for Legacy Adapters
COracle Studio For Legacy Adapters opens with the Configuration perspective
displawed. Right-click the Machines node to add an Oracle Connect for Legacy Adapters
machine,

Once a machine has been defined to Oracle Studio for Legacy Adapters, you can

[ Properties

ts 3:::) % configure the Following, using the Configuration perspective:

Propert |

Yalue

Bindings - The NaY binding configuration includes information about the

Location
Marne
Path

(05390, acrne, com: 255

05390
05390

adapters that can be accessed using Oracle Application Server 10g ProcessConneck,

Daemons - & daemon is responsible For cient/server communications, allocating
a server process for a client request,

Users - & user profile controls access to machines and applications
using user name and password pairs, instead of the user having to provide this
information when accessing the resource.

Securing Access to Oracle Connect for CICS

Oracle Studio includes mechanisms to secure access to Oracle Connect for CICS
both during modeling and at runtime.

During modeling the following security mechanisms can be applied:
= Setting Password Access to Oracle Studio
= Specifying Users with Administrative Rights

At runtime client access to the Oracle Connect for CICS backend adapter is
provided by the user profile:

= Setting Up Runtime User Access to the IBM OS/390 Machine
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Setting Password Access to Oracle Studio

Initially, any operation performed using Oracle Studio does not require a password.
You can set a password so that the first operation that involves accessing the server

from Oracle Studio requires a password to be entered.

Task: Setting Up a Master Password to Access Oracle Studio

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio. Oracle Studio opens.

2. Choose Window > Preferences from the menu bar. to open the Preferences

window.

3. Select the Studio node.

Studio

Security |

[~ use encrypted communication

¥ | Save password

Change master password |

Restore Defaults |

Apply |

Impoart. .. Expart...

[ = ]

Cancel |

Note: The Save password checkbox is for future use.

4. Click Change master password to open the Change master password window.
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@, Change master passwol |

Enter current master password:

Enter mew master password:

Confirm new master password:

oK I Cancel I

5. Leave the Enter current master password field empty and type a new master
password.

6. Confirm the password.

7. Click OK.

Specifying Users with Administrative Rights

By default, only the user who was specified during the installation as an
administrator has the authorization to modify settings on that machine from Oracle
Studio. This user can then authorize other users to make changes or to view the
definitions for a selected machine. Adding a machine to Oracle Studio is described
in "Task: Setting Up the IBM OS/390 Machine" on page 2-19.

Note: The default during installation is to enable all users to be
administrators.

Task: Setting Administrative Rights to a Machine

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio. Oracle Studio opens, displaying
the Configuration perspective.

2. Right-click the machine in the Configuration Explorer and choose
Administration Authorization from the popup menu.

The Administration Authorization window opens.

Installing the Oracle Application Server Integration Adapter for CICS 2-23



Securing Access to Oracle Connect for CICS

— Administrators

[V Everyone
&dd|User |
Add Group |
Fename |
Remove |
—Desigrners
- Everyone
Add User |
Add Group |
Rename |
Remove |
—Users
r Everyone
Add User |
Add Group |
Renane |
Remove |
Identities |

The window has three sections:

Administrators - Administrators can view and modify all the definitions in
Oracle Studio for the selected machine. On initial entry to Oracle Studio, every
user is defined as a system administrator.

Designers - Designers can view all the definitions for the machine in Oracle
Studio and can modify any of the definitions under the Bindings and Users
nodes for the selected machine. For example, Oracle Studio database
administrator can add new data sources and adapters and can change metadata
definitions for a table in a data source.

Users - Users can view all the definitions for the machine in Oracle Studio for
the selected machine. Regular users cannot modify any of the definitions.

3. Add users or groups of users by clicking Add User or Add Group for the
relevant sections.

The user or group that is added must be recognized as a valid user or group for
the machine.

Once a name has been added to a section, only the user or group who logs on
with that user name has the relevant authorization.
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Setting Up Runtime User Access to the IBM 0S/390 Machine

At runtime, client access to the Oracle Connect for CICS backend adapter is
provided by the user profile. A user profile contains name and password pairs that
are used to access a machine, data source or application at runtime, when
anonymous access is not allowed.

1. In the Configuration Explorer, click the + next to the machine node of the
machine for which you want to set the user name and password.

2. Click the + next to the Users node.
3. Right-click the NAV user profile and choose Edit User.

Caution: You must not delete the NAV user profile since it also
contains Oracle Connect for CICS system settings.
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Configuration - Oracle Studio for Legacy Adapters

File Edit Mavigate Search ‘Window Help

|IF-lgBal| ¢
= fig x| 1] welcome [f‘- maw X l
=22 Mchines
,E E‘B 05390 Resource User
£ Eindings
£ Daemans
2 Users

Add

Remove |
Edit |

[ Properties = x

Propert: | ‘alue
Marne MY
Path VOS5I usersiNA, ..
Filker
’]7 Datasource W Adapter W Remote machine W Encryprion key
| [ » nuthenticatorsISwrce

4. In the User editor, click Add to open the Add authenticator window.

5. Select the Remote Machine resource type.

;;:"‘. Add Authenticator
—Resource information

Resource bype: Remote machineg j
Daka source

Resource name:

iR emoke machine
Encryption ke

—Authentication infar

User name:

Password: I

Confirm password:

a4 I Cancel
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Enter the name of the IBM OS/390 machine defined in the previous task.

Enter the name and password used to access the machine and confirm the
password.

Click OK.
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Modeling Interactions for Oracle
Application Server Integration Adapter for
CICS

Modeling interactions for Oracle Application Server Integration Adapter for CICS
involves defining Oracle Connect for CICS using Oracle Studio. All the definitions
specified in Oracle Studio are written to the OS/390.

This chapter contains the following sections:
= Setting Up Oracle Connect for CICS
= Generating Outbound Interactions

= Generating Inbound Interactions
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Setting Up Oracle Connect for CICS

To work with Oracle Connect for CICS, you need to set up an adapter definition on
the OS/390 machine to handle the interactions to and from a CICS program. You
use Oracle Studio to specify these definitions.

Task: Setting Up the Adapter

1.

7.
8.

On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

In the Configuration Explorer, click the + next to the machine defined in
"Configuring Oracle Connect for CICS" on page 2-18.

Click the + next to the Bindings node. The binding configurations available on
this machine are listed.

Click the + next to the NAV binding node. The NAV binding configuration
includes branches for data sources and adapters that are located on the
machine.

Caution: You must not delete the NAV binding configuration
since it also contains Oracle Connect for CICS system settings.

Right-click Adapters and choose New Adapter from the popup menu, to open
the New Adapter wizard.

In the New window, enter a name for the adapter.

Note: The name specified for the adapter is also the name
specified setting up the delivery channel in Oracle Application
Server ProcessConnect. For details see, "Defining the Delivery
Channel" on page 4-2.

Note: The word event is a reserved word and cannot be used
when naming an adapter.

Select CICS as the backend adapter type from the Type drop-down list.
Check the Create event queue for the adapter checkbox.
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Note: Checking this box enables you to generate inbound
interactions, as described in "Generating Inbound Interactions" on

page 3-17.

editing.

Click Finish. The Adapter is added to the tree and the definition opened for

10. Select the Properties tab and change any of the properties for the adapter, as

required.

Adapter properties:

Propert I ‘alue

iexriTransid EXCI
targetSystemipplid CICS
transactionSupport  OPC
whamMetnarme BATCHCLI

General lProperties J

Property Description

exciTransid The CICS TRANSID. This value must be EXCI or a copy of this
transaction

targetSystemApplid The VTAM applid of the CICS target system.

You can determine this value by activating the CEMT
transaction on the target CICS system. On the bottom right
corner of the screen appears the legend APPLID=target_system.
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Property Description

transactionSupport  For future use. The level of transaction support for this adapter
that is reported to the transaction manager
In the current version leave this value as 0PC

vtamNetname The VTAM netname of the specific connection being used by

EXCI (and MRO) to relay the program call to the CICS target
system.

For example, if you issue to CEMT the following command:
CEMT INQ CONN

You see on the display screen that the netname is BATCHCLI
(this is the default connection supplied by IBM upon the
installation of CICS). If you plan to use the IBM defaults, then
specify BATCHCLI as the VTAM_netname parameter,
otherwise, define a specific connection (with EXCI protocol) and
use the netname you provided there for this parameter.

Generating Outbound Interactions

Oracle Connect for CICS requires metadata describing the adapter interactions,
including the structures used to pass information to and from the adapter.

Use the Import Metadata perspective in Oracle Studio to generate interaction

metadata for the adapter.
L

Task 1: Defining an Import Procedure

Task 2: Generating Outbound Interactions

Task 1: Defining an Import Procedure

1.

On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

In the Configuration Explorer, click the + next to the machine defined in
"Configuring Oracle Connect for CICS" on page 2-18.

Click the + next to the Bindings node. The binding configurations available on
this machine are listed.

Click the + next to the NAV binding node.
Click the + next to the Adapters node.
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6. Right-click the CICS adapter defined in "Setting Up Oracle Connect for CICS"
on page 3-2.

7. Choose Import from the popup menu, to open the Metadata Import

perspective, with the CICS adapter displayed under the Adapters list in the
Metadata Import Explorer.

8. Right-click the CICS adapter and choose New Import from the popup menu, to
open the New Metadata Import wizard.

9. Enter a name for the import. The name can contain letters and numbers and the
underscore character only.

10. Click Finish. The metadata import wizard opens in Oracle Studio.

;;gl:onﬁguration - Oracle Studio for Legacy Adapters

File Edit Mavigate Search ‘Window Help

=2 ] <
=l % || % *ccs_mporT X
i
,E =0 Adapters Get Input Files Step 1 of 5 ‘
— i E---q;_) CICS_ADAPTER
_____ £ ;Eources Select COBOL copybook Files:
L Events add...
Removel

= Properties ,E = =

Propert | ‘alue
Marne CICS_IMPORT
Path {05390%bindingst...

| < Back| |Next e | |Finish |

Main I Saource
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Task 2: Generating Outbound Interactions

After defining an import as described in the preceding task, the metadata import
wizard opens in Oracle Studio. COBOL copybooks are used to create the metadata.
The import wizard generates record structures, which are used for the input and
resulting output for outbound interactions.

1. Click Add to add COBOL copybooks.

A Select window opens. This window lists any files selected.

1o x|

2. Click Add.

The Add Resource window opens, which provides the option to select files
from the local machine or FIP the files from another machine.
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Add Resource

Resource Source
Select resource source D

£~ Import resource From remote machine

= Back I Mext = I Eiristy | Cancel I

3. If the files are on another machine, select the Import resource from remote
machine option to start a file transfer process from the machine.

4. Click Next to open the File Transfer wizard.
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File Transfer

File Transfer D '-1

Connection data:

FTP Server: | (05390, acme, com

Lsernarme: |

Password: |

I Anonyrous cannection

< Back | Text = | Eimish I Cancel I

5. Enter the server name where the COBOL copybooks reside and, if not using
anonymous access, enter a username and password to access the machine.

6. Click Next. The machine is accessed and the directory structure displayed,
enabling you to browse to the files to be transferred.
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File Transfer D '-1
Files ko refrieve:
ED 'TEST.AC4000. ACCLICBD =
-] BULLDKIT ACCLICE]

ACCLICEM
ACCLICER
A

CPOCEY
ACTCE]
ACTC]
BCICS3GL
BLDODEC
BLDPROC
CRCCL b
[T USERLIB CCamENO
CICS3GL

COBDEMO ;I

BAA TS

Directory name: I ‘TEST. AC4000, SAMPLES' Chg Roat Dir |
File name: I ACDOCPY; ACPOCPY; COBCPL

Transfer mode: ¢ Text

< Back I Mext = I Eimish | Cancel I

You access the OS/390 machine at the high-level qualifier for the user name. To
change the high-level qualifier, enter the name of the high-level qualifier in the
Directory name field and click the Chg Root Dir button.

7. Navigate to the location where the files reside and select the files to be
transferred and the transfer method (Text or Binary)

8. Click Next. A summary screen is displayed with details of what is going to be
transferred.

9. Click Finish to start the transfer. The Select window is redisplayed with the list
of transferred files.
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~loi x|

10. Select the files you want to use in the import and click OK.

Note: You can import the metadata from one COBOL copybook
and later add to this metadata by redoing the import using different
COBOL copybooks.

The format of the COBOL copybooks must be the same. That is,
you cannot import a COBOL copybook that uses the first six
columns with a COBOL copybook that ignores the first six
columns. In this case, you must do separate imports.

3-10 Oracle Application Server Integration Adapter for CICS Installation and User’s Guide



Generating Outbound Interactions

onfiguration - Oracle Studio for Legacy Adapters

File Edit Mavigate Search ‘Window Help

8| ¢

% || % *ccs_mporT X

Get Input Files

=)
i
,E ED Adapters

Step 1 of 5 ‘
=2 CICS_ADAPTER
0
0 DatEDurces Select COBOL copybook Files:
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Marne CICS_IMPORT
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11. When you have completed adding the list of copybooks, click Next.
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‘ Apply Filters Step 2 of 5 ‘

‘ Click Mext ta analvze and convert the source files. You may alsa change warious Filker optians, ‘

Property | Yalue |
cobolFiler e
ignoreFirska false
ignoreFrom?2 krue
prefixMestedColumns false
[= template
ignoreCase krue

replace
search

|<< Backl |Next > | |Finish |

Main J Source

12. Apply filters to the copybooks.
The following filters are available:
ignoreFirst6 - Ignore the first six columns in the COBOL copybook.
ignoreFrom?72 - Ignore columns 73 to 80 in the COBOL copybook.

prefixNestedColumns - Prefix all nested columns with the previous level
heading.

In addition, you can specify a search string and the string that will replace this
search string in the generated metadata, and whether the replacement is
dependent on the case of the found string.

13. Click Next to apply the filter settings. The Add Interactions window opens.
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Add Interactions Step 3 of 5 |

Add Interactions:

[ arne | Mode | Inpuk | Cukpuk | Description | add

Remave |

 Inkeraction-Specific Parameters

Propert: | Value |

| < Back| |Next E>3 | |Finish |

Main J Source

14. Click Add to add an interaction for the CICS adapter.
Interaction name - The name of the interaction.
Mode - The interaction mode:
= sync-receive - The interaction expects to receive a response.

= sync-send - The interaction sends a request and does not expect to receive a
response.

= sync-send-receive - The interaction sends a request and expects to receive a
response.

Input - Identifies an input record. The input record is the data structure for the
outbound interaction. The records generated from the COBOL programs
specified at the beginning of the procedure are listed in a drop-down list. Select
the relevant record for the interaction.
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Note: You must specify an input record for each interaction before
you can click Next.

If the interaction does not require an input record, the record
specified here is ignored.

Output - Identifies an output record. The output record is the data structure for
the results of the outbound interaction. The records generated from the COBOL
programs specified at the beginning of the procedure are listed in a drop-down
list. Select the relevant record for the interaction.

Note: You must specify an output record for the interaction if the
mode is set to sync-send-receive or sync-receive, before
you can click Next.

Description - Free text describing the interaction.

Interaction-Specific Parameters - The name of the program that is called to
execute the interaction.

Note: You must specify a program name for each interaction.

15. Add as many interactions as necessary and then click Next.
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16. Click Next to generate the metadata definitions for the adapter.
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‘ Import Metadata Step 5of 5 |

‘ Click Finish ko end the import process, ‘

Deploy Metadata:
Do wou want ko transfer the metadaka to the server?

* No
 Yes

| <= Back| |Next S | |Finish |

17. Specify that you want to transfer the metadata from the Windows machine to
the OS/390 machine and click Finish.

The metadata is imported based on the options specified and it is stored on the
0S/390 machine with the data source. An XML representation of the metadata is
generated. This XML file can be viewed by expanding the Output node.

=7 Adapters
| E-E CICS_ADAPTER
: =4 CICS_IMPORT
- Input
E|$ Cukput
H [ (g r=tadata_cics., xml
7 Data sources

[ D Everts

After performing the import, you can view the metadata in the Metadata
perspective in Oracle Studio. You can also make any fine adjustments to the
metadata and maintain it, as necessary.

See Also: "Interaction Metadata for the Adapter" on page A-2 for
details about the adapter metadata

3-16 Oracle Application Server Integration Adapter for CICS Installation and User’s Guide



Generating Inbound Interactions

Generating Inbound Interactions

Inbound interactions are defined as events in Oracle Studio. When you defined the
Oracle Connect for CICS backend adapter with the Create event queue for the
adapter box checked, as described in "Task: Setting Up the Adapter" on page 3-2, an
event adapter was defined automatically. The event adapter is defined with the
same name as the backend adapter with the word event appended to it. The
backend adapter and the event adapter are linked by Oracle Studio. You can jump
from one adapter definition to the other by right-clicking the adapter or event in the
Configuration Explorer list and choosing the Linked Event or Linked Adapter
option respectively.

The event adapter requires metadata describing the inbound interactions, including
the structures used to pass information to and from the adapter.

Use the Import Metadata perspective in Oracle Studio to generate interaction
metadata for the adapter.

s Task 1: Defining an Import Procedure

s Task 2: Generating Inbound Interactions

Task 1: Defining an Import Procedure

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. In the Configuration Explorer, click the + next to the machine defined in
"Configuring Oracle Connect for CICS" on page 2-18.

3. Click the + next to the Bindings node. The binding configurations available on
this machine are listed.

4. Click the + next to the NAV binding node.
5. Click the + next to the Adapters node.

6. Right-click the CICS adapter defined in "Setting Up Oracle Connect for CICS"
on page 3-2.

7. Choose Linked Event from the popup menu, to jump to the event adapter.
8. Right-click the event adapter and choose Edit Event from the popup menu.

9. Select the Properties tab to add the names of Oracle Application Server
ProcessConnect users who can retrieve inbound interactions and OS/390 users
who can send inbound interactions.
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10. To add Oracle Application Server ProcessConnect users, click the + next to the
routers node and right click the users property to add the user.

Adapter properties:

Propert | Walue |

[Slrauters

[=] senders

Add Tkem
users [0] - Rigl A= Ta [u =T

3y item

General lPropertiesJ
11. Enter the name of the Oracle Application Server ProcessConnect user in the
Value column for the item added.

12. To add OS/390 users, click the + next to the senders node and right click the
users property to add the user.

13. Enter the name of the OS/390 user in the Value column for the item added.
14. Click the Save Editor Contents button to save the changes.

15. Right-click the event adapter in the Configuration Explorer and choose Import
from the popup menu, to open the Metadata Import perspective, with the event
adapter displayed under the Events list.

16. Right-click the event adapter and choose New Import from the popup menu, to
open the New Metadata Import wizard.

17. Enter a name for the import. The name can contain letters and numbers and the
underscore character only.
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18. Select Event Queue Import Manager Using Cobol COPYBOOK Input Files for
the Import Type.

Metadata Import

/TS
Create new Metadata Import

Adapter: | CI1C5_ADAPTEREvent

Irnpork Marne: I INBOUMD _IMPORT

Impork Type: IEvent Queue Import Manager Using Cobol COPYBOOK Files j

Finish I Cancel I

19. Click Finish. The metadata import wizard opens in Oracle Studio.
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;,‘%Eonﬁguration - Oracle Studio for Legacy Adapters

File Edit Mavigate Search ‘Window Help

IF-lgBal| ¢

ﬁ E Metadata Impaort Explorer ®
ﬁ =] Adapters

i E-8) CICS_ADAPTER 7 ‘
oy E‘E CICS_IMPORT Get Input Files Step 1 of 5
i -4y Input

-6 Oubput Select COBOL copybook files:

[ metadata_cics, xml bl
[T Data sources

E‘D Events Remove |
E-4@ CICS_ADAPTEREwent

(-8 INEOLIND_IMPORT

= Properties = X

Propert | ‘Value |
Marne IMBOUND_IMPORT
Path {05390%bindingst...

| < Back| |Next e | |Finish |

Main | Source

Task 2: Generating Inbound Interactions

After defining an import as described in the preceding task, the metadata import
wizard opens in Oracle Studio. COBOL copybooks are used to create the metadata.

The import wizard generates record structures, which are used for the record
structures for inbound interactions.

Note: The generation of inbound interactions involves similar
steps to the steps described to generate outbound interactions. For
details, see "Task 2: Generating Outbound Interactions" on page 3-6.

1. Click Add to add COBOL copybooks.

A Select window opens. This window lists any files selected.
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Click Add.

The Add Resource window opens, which provides the option to select files
from the local machine or FIP the files from another machine.

If the files are on another machine, select the Import resource from remote
machine option to start a file transfer process from the machine.

Click Next to open the File Transfer wizard.

Enter the server name where the COBOL copybooks reside and, if not using
anonymous access, enter a username and password to access the machine.

Click Next. The machine is accessed and the directory structure displayed,
enabling you to browse to the files to be transferred.

You access the OS/390 machine at the high-level qualifier for the user name. To
change the high-level qualifier, enter the name of the high-level qualifier in the
Directory name field and click the arrow button.

Navigate to the location where the files reside and select the files to be
transferred and the transfer method (Text or Binary)

Click Next. A summary screen is displayed with details of what is going to be
transferred.

Click Finish to start the transfer. The Select window is redisplayed with the list
of transferred files.

10. Select the files you want to use in the import and click OK.

Note: You can import the metadata from one COBOL copybook
and later add to this metadata by redoing the import using different
COBOL copybooks.

The format of the COBOL copybooks must be the same. That is,
you cannot import a COBOL copybook that uses the first six
columns with a COBOL copybook that ignores the first six
columns. In this case, you must do separate imports.
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&

4=} Configuration - Oracle Studio for Legacy Adapters
File Edit Mavigate Search ‘Window Help

IF-lgBal| ¢

ﬁ E Metadata Import Explorer * ot
ﬁ =] Adapters
i I3 CICS_ADAPTER
oy -4 CICS_IMPORT Get Input Files Step 1 of 5
= ‘ Oukput Seleck COBOL copybook files:
£ bt + [ metadata_cics.xml customers,cob Add...
| ata sources

E‘D Everts Remoye |
E-4@ CICS_ADAPTEREwent

(-8 INEOLIND_IMPORT

= Properties ,E = B x
[

Propert | ‘Value
Marne IMBOUND_IMPORT
Path {05390%bindingst...

| < Back| |Next e | |Finish |

Main | Source

11. In the metadata import wizard, click Next after you have completed adding the
list of copybooks.
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‘ Apply Filters Step 2 of 5 ‘

‘ Click Mext ta analvze and convert the source files. You may alsa change warious Filker optians, ‘

Property | Yalue |
cobolFiler e
ignoreFirska false
ignoreFrom?2 krue
prefixMestedColumns false
[= template
ignoreCase krue

replace
search

|<< Backl |Next > | |Finish |

Main J Source

12. Apply filters to the copybooks.
The following filters are available:
ignoreFirst6 - Ignore the first six columns in the COBOL copybook.
ignoreFrom?72 - Ignore columns 73 to 80 in the COBOL copybook.

prefixNestedColumns - Prefix all nested columns with the previous level
heading.

In addition, you can specify a search string and the string that will replace this
search string in the generated metadata, and whether the replacement is
dependent on the case of the found string.

13. Click Next to apply the filter settings. The Add Events window opens.
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Add Events Step 3 of 5 |

Add Events:
[ arne | Mode | Inpuk | Cukpuk | Description | add
Remo\rel

| < Back| |Next E>3 | |Finish |

Main J Source

14. Click Add to add an interaction for the CICS adapter.
Interaction name - The name of the interaction.
Mode - The interaction mode:

async-send - The inbound interaction sends a request and does not expect
to receive a response.

Input - Identifies an input record. The input record is the data structure for the
inbound interaction. The records generated from the COBOL programs
specified at the beginning of the procedure are listed in a drop-down list. Select
the relevant record for the interaction.

Note: You must specify an input record for each interaction before
you can click Next.

Output - For internal use. You cannot specify a value in this field.
Description - Free text describing the interaction.

15. Add as many interactions as necessary and then click Next.
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16. Click Next to generate the metadata definitions for the adapter.
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‘ Import Metadata Step 5of 5 |

‘ Click Finish ko end the import process, ‘

Deploy Metadata:
Do wou want ko transfer the metadaka to the server?

* No
 Yes

| <= Back| |Next S | |Finish |

17. Specify that you want to transfer the metadata from the Windows machine to
the OS/390 machine and click Finish.

The metadata is imported based on the options specified and it is stored on the
0S/390 machine. An XML representation of the metadata is generated. This XML
file can be viewed by expanding the Output node.

After performing the import, you can view the metadata in the Metadata
perspective in Oracle Studio. You can also make any fine adjustments to the
metadata and maintain it, as necessary.

See Also: "Interaction Metadata for the Adapter" on page A-2 for
details about the adapter metadata
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Using Interactions in a Business Process

After Oracle Connect for CICS has been modeled as described in Chapter 3,
"Modeling Interactions for Oracle Application Server Integration Adapter for CICS",
the interactions can be used in a business process in Oracle Application Server
ProcessConnect. You define a delivery channel for the CICS adapter part of the
Oracle Application Server Integration Adapter for CICS. This delivery channel is
used during the modeling in Oracle Application Server ProcessConnect with the
interactions defined for the adapter in Oracle Studio in a business process.

This chapter contains the following sections:

= Adding the CICS Adapter in Oracle Application Server ProcessConnect
= Defining the Delivery Channel

= Modifying an Adapter in Oracle Studio

s Comparing a ProcessConnect XSD to an Oracle Connect Record Schema
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Adding the CICS Adapter in Oracle Application Server ProcessConnect

When adding the adapter type during the application definition, specify CICS
Adapter.

See Also: Oracle Application Server ProcessConnect User’s Guide for
details of setting up applications in Oracle Application Server
ProcessConnect

Defining the Delivery Channel

Part of the application definition includes adding a delivery channel for the Oracle
Application Server Integration Adapter for CICS.

The delivery channel identifies where the OS/390 backend adapter is located and
the necessary security and encryption requirements to access the adapter.

Task: Setting Up the Delivery Channel

1. In the Create Delivery Channel page for the adapter, add the following
information to create a delivery channel.

Field Description

Name A name for this delivery channel

You must provide a value for this field

The Adapter Name The name of the Oracle Connect for CICS backend
adapter to use, as defined in Oracle Studio. You can
check the name specified for the adapter in Oracle Studio

You must provide a value for this field

The Workspace to use The name of a server workspace to use. Leave blank to
use the default workspace. If you used another
workspace when modeling the adapter in Oracle Studio,
you can check the workspace name in the Configuration
perspective in Oracle Studio

The Remote machine Name The server machine TCP/IP host name. The host name is
the name of the machine where the Oracle Connect for
CICS backend adapter was defined using Oracle Studio

You must provide a value for this field
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Field

Description

The Port to connect

Protocol Name

Timeout via Connect
Encryption protocol name

Encryption key name
Encryption key value

The User Name
The User Password

Directory to store rejected
inbound interactions

The TCP/IP port where the daemon is running on the
server. The default port is 2552. If you specified another
port when modeling the adapter in Oracle Studio, you
can check the port specified by right-clicking on the
machine in Oracle Studio and checking the port number
displayed

The firewall protocol used: either none or fixedNat (the
Nat protocol using a fixed address for the daemon). The
default is none

Connection timeout in seconds. The default is 0, meaning
that there is no connection timeout

Name of encryption protocol to use. The default is null.
The RC4 protocol is supported

Name of the symmetric encryption key to use
Value of the symmetric encryption key to use

The backend user name for authentication. Leave blank
if anonymous access is allowed.

The backend user password for authentication. Leave
blank if anonymous access is allowed

The directory where files with information about rejected
inbound interactions are stored. Each rejected inbound
interaction is stored in a file whose name consists of a
timestamp and the interaction name.

Click Apply.

The delivery channel is defined for the application and the Delivery Channels
Details page for the added delivery channel is displayed.

You can now select any of the interactions defined for the adapter.

Note:

You cannot add, modify or delete interactions for the

adapter from Oracle Application Server ProcessConnect. Any
changes to the interactions must be done in Oracle Studio.
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Modifying an Adapter in Oracle Studio

The procedure for making changes in Oracle Studio to an interaction or to the
interaction input and output records and having the change reflected in Oracle
Application Server ProcessConnect depends on whether the configuration was
deployed or not.

Before the configuration has been deployed, delete the interaction from the
application (and all relevant items that reference the interaction) and after making
the change in Oracle Studio, add the changed interaction to the application.

After the configuration has been deployed, you cannot change the interaction until
you have performed the following procedure:

1. Stop both the adapter framework and integration manager processes.

2. Delete the interaction from the application (and all relevant items that reference
the interaction).

Make the changes to the interaction in Oracle Studio.
In the same application, add the changed interaction.

Redeploy the configuration.

o o & W

Start both the adapter framework and integration manager processes.

Comparing a ProcessConnect XSD to an Oracle Connect Record

Schema

The interaction that is modeled in Oracle Studio is automatically translated to an
xsd presentation in Oracle Application Server ProcessConnect. The xsd can be
viewed by displaying the record in the Native Dataypes window (under Modeling
> Datatypes).

The following example shows the Oracle Application Server ProcessConnect xsd for
an input record.

<xsd:schema xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns="noNamespace://05390/Navigator/CustAccount#findCustAccountInput"
targetNamespace="noNamespace://05390/Navigator/CustAccount#findCustAccountInput"
elementFormDefault="qualified">
<xsd:element name="findCustAccountInput" type="findCustAccountInput"/>
<xsd:complexType name="findCustAccountInput">
<xsd:attribute default="ATCLIENT" name="EYE-CATCH" type="xsd:string"/>
<xsd:attribute name="ACCT-NUM" type="xsd:string"/>

4-4 Oracle Application Server Integration Adapter for CICS Installation and User’'s Guide



Comparing a ProcessConnect XSD to an Oracle Connect Record Schema

</xsd:complexType>
</xsd:schema>

The Oracle Connect metadata for the input record, which was the source for the
above xsd, is part of the metadata definition:

<record name="findCustAccountInput">
<field name="EYE-CATCH" type="string" default="ATCLIENT"
size="8" nativeType="string"/>
<field name="ACCT-NUM" type="string" size="9" nativeType="numstr_u"/>
</record>

The Oracle Connect metadata definition can be viewed in Oracle Studio as follows:

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for CICS" on
page 2-18.

Click the + next to the Bindings node.
Click the + next to the NAV binding node.
Click the + next to the Adapters node to display the adapters.

o o & v

Right-click the CICS adapter in the Configuration Explorer and choose Edit
Metadata to open the Metadata perspective.

7. Right-click the adapter in the Metadata Explorer and choose Edit definition.
8. Choose the Source tab to review the metadata definition.

The metadata definition includes the following parts:

= General information about the adapter

» Information about each interaction, including the names of the input and
output record

s The record schemas used to support the interactions, including input and
output (response) record schemas

The following example shows the Oracle Application Server ProcessConnect xsd for
an output record.

<xsd:schema xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns="noNamespace://05390/Navigator/CustAccount#findCustAccountResponse"
targetNamespace="noNamespace://05S390/Navigator/CustAccount#findCustAccountRespon
se" elementFormDefault="qualified">

Using Interactions in a Business Process 4-5



Comparing a ProcessConnect XSD to an Oracle Connect Record Schema

<xsd:element name="findCustAccountResponse" type="findCustAccountResponse"/>

<xsd:complexType name="findCustAccountResponse">
<xsd:attribute name="RET-CODE" type="xsd:string"/>
<xsd:attribute name="ACCT-ID" type="xsd:string"/>
<xsd:attribute name="ACCT-FIRST-NAME" type="xsd:string"/>
<xsd:attribute name="ACCT-LAST-NAME" type="xsd:string"/>
<xsd:attribute name="ACCT-BIRTH-DATE" type="xsd:string"/>
<xsd:attribute name="ACCT-MARRIED" type="xsd:int"/>
<xsd:attribute name="ACCT-CHILDREN" type="xsd:int"/>
<xsd:attribute name="ACCT-TOTAL-ASSETS" type="xsd:int"/>
<xsd:attribute name="ACCT-EMPLOYED" type="xsd:int"/>
<xsd:attribute name="ACCT-OVERTIME-HOURS" type="xsd:int"/>
<xsd:attribute name="ACCT-COMMISSION" type="xsd:float"/>
<xsd:attribute name="ACCT-SALARY" type="xsd:double"/>
<xsd:attribute name="ACCT-BALANCE" type="xsd:decimal"/>
<xsd:attribute name="ACCT-VACATION-DAYS" type="xsd:string"/>

</xsd:complexType>

</xsd:schema>

The Oracle Connect metadata for the output record has the following structure:

<record name="findCustAccountResponse">
<field name="RET-CODE" type="string" nativeType="int4"/>
<field name="ACCT-ID" type="string" size="9" nativeType="numstr_u"/>
<field name="ACCT-FIRST-NAME" type="string" size="20" nativeType="string"/>
<field name="ACCT-LAST-NAME" type="string" size="20" nativeType="string"/>
<field name="ACCT-BIRTH-DATE" type="string" size="8" nativeType="numstr_u"/>
<field name="ACCT-MARRIED" type="int" nativeType="int2"/>
<field name="ACCT-CHILDREN" type="int" nativeType="int4"/>
<field name="ACCT-TOTAL-ASSETS" type="int" nativeType="int8"/>
<field name="ACCT-EMPLOYED" type="int" nativeType="int2"/>
<field name="ACCT-OVERTIME-HOURS" type="int" nativeType="intd"/>
<field name="ACCT-COMMISSION" type="float" nativeType="single"/>
<field name="ACCT-SALARY" type="double" nativeType="dfloat"/>
<field name="ACCT-BALANCE" type="numeric" size="9"
scale="-2" nativeType="decimal"/>
<field name="ACCT-VACATION-DAYS" type="string" size="3"
nativeType="numstr_s"/>
</record>
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Oracle Application Server Integration
Adapter for CICS Features

After the Oracle Application Server Integration Adapter for CICS is installed and
the modeling described in Chapter 3, "Modeling Interactions for Oracle Application
Server Integration Adapter for CICS" and Chapter 4, "Using Interactions in a
Business Process" completed, you can use the Oracle Application Server Integration
Adapter for CICS to invoke interactions that access programs under CICS.

This chapter contains the following sections:
= Sending Inbound Interactions Using a CICS Transaction

» High Availability with Oracle Connect
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Sending Inbound Interactions Using a CICS Transaction

The Oracle Application Server Integration Adapter for CICS includes a set of APIs
that enable sending a native event as an inbound interaction from a COBOL
program, using a CICS transaction.

See Also: Appendix D, "COBOL APIs to Applications” for details
of APIs that can be used when not working under CICS

To send an inbound interaction, perform the following tasks:

»  Task 1: Setting Up the IBM OS/390 Machine

»  Task 2: Setting Up a Call to the CICS Transaction

Task 1: Setting Up the IBM 0S/390 Machine

Before you can use the CICS transaction, set it up using the following procedure:
1. Copy INSTROOT.LOAD (ATTCICSD) to a CICS DFHRPL library.
2. Copy INSTROOT.LOAD (TRANS3GL) to a CICS DFHRPL library.

Note: Make sure that the CICS Socket Interface is enabled. You
can enable this interface by issuing the following CICS command:

EZAO START CICS

Refer to the TCP/IP V3R2 For MV'S: CICS Sockets Interface Guide. 1f
you are not sure if the system is configured with the Socket
Interface, try running the EZAC transaction. If the transaction
produces a screen, you should be able to run the EZAO startup
transaction. If not, see if the transaction has been defined in a group
that has not been installed, for example: CEDC V TRANS (EZAC)
G(*).

If it is defined in a group, install that group and try running EZAO
again. If not, you have to configure CICS as outlined in the TCP/IP
V3R2 For MVS: CICS Sockets Interface Guide.

3. Set up CICS resource definitions for the COBOL program from which you want
to send a native event as an inbound interaction.

The following JCL can be used as a template:
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//ATTCSD JOB

//STEPLIB DD
//DFHCSD DD
//OUTDD DD
//SYSPRINT DD
//S8YSIN DD

'ORACLE', 'CSD',MSGLEVEL=1, NOTIFY=&SYSUID
//STEPL EXEC PGM=DFHCSDUP, REGION=512K,

// PARM="'CSD (READWRITE) , PAGESIZE (60) , NOCOMPAT"'
DSN=<HLQ1>.SDFHLOAD, DISP=SHR
UNIT=SYSDA, DISP=SHR, DSN=<HLQ2>.CSD
SYSOUT=*

SYSOUT=*

*

*/********************************************************************/

*/* ORACLE CICS Definitions */

*/*

*/

*/********************************************************************/

K e e e *
* Note: Install GROUP(ORA) - CEDA IN G(ORA) *
* If you are rerunning this, uncomment the DELETE command. *
E e *

* Start ORACLE RESOURCES:

* DELETE

GROUP (ORA)

DEFINE PROGRAM (ATTCICSD) GROUP(ORA) LANGUAGE (C) DATALOCATION (ANY)
DE(Oracle DLL)

DEFINE PROGRAM (TRANS3GL) GROUP(ORA) LANGUAGE (C) DATALOCATION (ANY)
DE (Oracle DLL)

DEFINE PROGRAM (<PROG>) GROUP(ORA) LANGUAGE (<LANG>) DATALOCATION (ANY)
DE (Oracle)

DEFINE TRANSACTION (<ORATRAN>) GROUP(ORA) PROGRAM (<PROG>)
TASKDATAL (ANY)
DE(Oracle TRAN ID)

LIST

*

GROUP (ORA)

* End ORACLE RESOURCES

*
/*
//

Make the following changes before running the JCL:
1. Modify the JCL, as follows:
— Change the JOB card to suit the site.
— Change <HLQ1> to point to the CICS SDFHLOAD library.
- Change <HLQ2> to point to the CICS CSD dataset.
— Change <LANG> to the LE370 for COBOL.
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- Change <PROG> to the COBOL program name.

- If you are calling the COBOL program from a CICS transaction, change
<ORATRAN?> to the CICS transaction name that calls the COBOL
program.

2. From CICS, install the ORA group, by issuing the following command:

CEDA IN G(ORA)

Task 2: Setting Up a Call to the CICS Transaction

The COBOL program sets up a buffer in the CICS COMMAREA that contains the
information needed for the inbound interaction and then calls the TRANS3GL
transaction to send the interaction.

The buffer is formatted as follows:

Parameter Size Description
Version 4 The version of the APIs used. The expected value is 1
ServersUrl 256  The URL of the OS/390 machine and the port number where

the Oracle Connect for CICS backend adapter runs. For
example, IP1:2552, where IP1 is the URL and 2552 is the port

Username 64 A valid username to access the OS/390 machine
Password 64 A valid password for the user name

Workspace 64 A daemon workspace. The default is Navigator
AdapterName 64 The name of the adapter defined in Oracle Studio

SchemaFileName 256 For future use. Leave blank

EncKeyName 64 For future use. Leave blank
EncKeyValue 256  For future use. Leave blank
InteractionName 64 The name of the interaction as defined in Oracle Studio

5-4 Oracle Application Server Integration Adapter for CICS Installation and User’'s Guide



Sending Inbound Interactions Using a CICS Transaction

Parameter Size Description

Flags 4 The following flags are available:
= 1- A trace of the XML is performed
= 2- A trace of the communication calls is performed
= 3 - Both the XML and communication calls are traced

= 4-The NAT firewall protocol is used, with a fixed address
for the daemon

= 5- A trace of the XML is performed and the NAT firewall
protocol is used, with a fixed address for the daemon

= 6- A trace of the communication calls is performed and
the NAT firewall protocol is used, with a fixed address for
the daemon

s 7 -Both the XML and communication calls are traced and
the NAT firewall protocol is used, with a fixed address for
the daemon

Input format 4 The following formats are available:
= 0-Inputis provided as XML

= 1-Inputis provided using parameters
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Parameter Size Description

Input - The size of the input depends on the value specified in the
Input size parameter

If the Input format is set to 0 (XML), the input is formatted as
follows:

= The first four bytes specify the size of the input XML string

= The next 64 bytes specifies the name of the record used for
the output (the inbound interaction)

= The next bytes (to the exact length specified in the first
four bytes) specify the input XML string. For example:
<findorder ORDER_NO='17’ /> where findorder is
the inbound interaction name

If the Input format is set to 1 (the input is done using
parameters), the input is formatted as follows:

= The first four bytes specify the number of parameters

= The next 4 bytes specify the maximum size of any
parameter value

= The next 64 bytes specify the name of the record used for
the output (the inbound interaction)

= The next 32 bytes specify the name of the parameter

= The next bytes (to the exact length specified in the first
four bytes) specify the input parameter

= The following bytes repeat the last two entries until all the
parameters are specified

The buffer is defined as follows:

*

* COBOL COPY OF DATA BUFFER

*

01 COMM-DATA-BUFF PIC X(5000).

01 COMM-DATA-BUFF-ERROR REDEFINES COMM-DATA-BUFF.
05 COMM-ERROR-STATUS PIC S9(8) COMP SYNC.
05 COMM-ERROR-MSG PIC X(256).

01 COMM-DATA-BUFF-INPUT REDEFINES COMM-DATA-BUFF.
05 INPUT-COMMAREA-3GL.

10 INCOM-VERSION PIC S9(8) COMP SYNC.
10 INCOM-SERVERS-URLS PIC X(256).
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* /* IP1:PORT[,IP2:PORT] [,...] */

10  INCOM-USER-NAME PIC X(64).

10  INCOM-PASSWORD PIC X(64).

10  INCOM-WORKSPACE PIC X(64).

10  INCOM-ADAPTER-NAME PIC X(64).

10  INCOM-SCHEMA-FILE-NAME PIC X(256).

10  INCOM-ENC-KEY-NAME PIC X(64).

10  INCOM-ENC-KEY-VALUE PIC X(256).

10  INCOM-INTERACTION-NAME PIC X(64).

10  INCOM-DW-FLAGS PIC S9(8) COMP SYNC.
10  INCOM-INP-FORMAT PIC S9(8) COMP SYNC.

10 INCOM-EXEC-INPUT.
15 INCOM-XML-BUFF.

20
20

* ====>>> CHANGE
20

INCOM-XML-ILEN PIC S9(8) COMP SYNC.
INCOM-XML-INTER-OUTREC-NAME

PIC X(64).
??? TO LEN SPECIFIED IN INCOM-XML-ILEN
INCOM-XML-INPUT PIC X(???).

15 INCOM-PARAM-BUFF REDEFINES INCOM-XML-BUFF.

20
20
20
* ====>>> CHANGE
20

* ====>>> CHANGE

INCOM-PARAM-COUNT PIC S9(8) COMP SYNC.
INCOM-PARAM-VALUE-LEN PIC S9(8) COMP SYNC.
INCOM-PARAM-INT-OUTREC-NAME PIC X(64).
?? TO COUNT SPECIFIED IN INCOM-PARAM-COUNT
INCOM-PARAM-NAME-VALUE OCCURS ?? TIMES.

25 INCOM-PARAM-NAME PIC X(32).

?? TO LEN SPECIFIED IN INCOM-PARAM-VALUE-LEN
25 INCOM-PARAM-VALUE PIC X(??).

01 COMM-DATA-BUFF-OUTPUT REDEFINES COMM-DATA-BUFF.

05 COMM-OUT-STATUS PIC S9(8) COMP SYNC.
05 COMM-OUT-LENGTH  PIC S9(8) COMP SYNC.

05 COMM-OUT-DATA

PIC X(4992)

The TRAN3GL transaction is called as follows:

EXEC CICS LINK PROGRAM/("TRANS3GL")

COMMAREA

(commDataBuff)

LENGTH (iCommSize) ;

where:

commDataBuff - The buffer with the interaction details, used in the COMMAREA.

Oracl
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iCommSize - The size of the buffer. This value is also used to determine the size of
the output string. Thus make sure the value is big enough for the expected output.

After defining the COMMAREA and calling the TRAN3GL transaction in the
COBOL program, compile and move the COBOL program to a CICS DFHRPL
(LOAD,) library.

The output includes a 4 byte success flag: Zero for success, otherwise failure. The
output overrides the input. If the result is failure, an error message with a length of
256 bytes is returned.

If XML was specified for the input and the result is success, the output is formatted
as XML, as follows:

= The first four bytes specify the size of the output
= The following bytes make up the XML output

If parameters were specified for the input and the result is success, the output is
formatted as follows:

= The first four bytes specify the size of the output
= The next 32 bytes specify the name of the output attribute

= The next bytes (to the exact length specified for the input string in the) specify
the output value

= The following bytes repeat the last two entries until all the output is specified

High Availability with Oracle Connect

You can configure a pool of server processes so that a server process is always
available for a client request.

See Also: "Configuring the Daemon for High Availability" on
page 7-2 for details about high availability
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Troubleshooting the Oracle Application
Server Integration Adapter for CICS

Troubleshooting Oracle Application Server Integration Adapter for CICS can
involve checking both Oracle Application Server ProcessConnect and Oracle
Connect for CICS.

This chapter contains the following sections:
= Design-Time Troubleshooting

= Troubleshooting the Daemon
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Design-Time Troubleshooting

The most common cause of errors when defining the Oracle Application Server
Integration Adapter for CICS is incorrect definitions in the delivery channel. If you

encounter problems during the modeling phase, check the delivery channel
definitions.

See Also: Task: Setting Up the Delivery Channel on page 4-2 for
details of setting up the delivery channel

The following errors occur during the modeling of interactions, when using a
delivery channel that was defined incorrectly.

Specifying the Wrong Adapter Name

The following error occurs when the wrong adapter name is specified in the
delivery channel:

@ Error

An error occurred while attempting to log in with the selected delivery channel.

javax.resource. ResourceException : Error in Connecting to server © javax.resource.spi. CommEsxception: [J036] = client. noSuchResource
(acx.connect): [¥020] Requested resource, ‘wrong_adapter_name', is not available on this server

Add Interaction: Login

Flease enter the login information and select Apply. Information entered will be saved for the delivery channel and a login will be attempted.

Name Itest
The Adapter Name@dapt@
The Waorkspace to use I
The Remate machine name |1931.9E|.22 83
The Port to connect |2551

Check that the name specified for the adapter is the same as the name specified in

the delivery channel.

Specifying the Wrong Workspace Name

The following error occurs when the wrong workspace name is specified in the

delivery channel:
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@ Error

An error occurred while attermnpting to log in with the selected delivery channel.

Javax. resource. ResourceException © Error in Connecting to server : javax.resource. spi. CommException: [JO36] = client.requestErrar
(daemaon.connect): Warkspace wrang_workspace’ not found

Add Interaction: Login

Please enter the login information and select Apply. Information entered will be saved for the delivery channel and a login will be attempted.

Marme |test

The Adapter Mame |accoum
The Workspace to use@wor@
The Rernote machine name |194.90.22.BB
The Port to connect |2551

Check that the name specified for the adapter is the same as the name specified in
the delivery channel.

Specifying the Wrong Machine

The following error occurs when the remote machine is specified incorrectly:

@ Error

An error occurred while attempting to log in with the selected delivery channel.

javax.resource. ResourceException : Emor in Connecting 1o server © javax. resource.spi. CommEsxception: [J036] = client. noSuchResource
[acx.connect): [¥020] Requested resource, ‘account’, is not available on this serer

Add Interaction: Login

Pleage enter the login information and select Apply. Information enterad will be saved for the delivery channel and a login will be attempted.

Mame Itest

The Adapter Mame Iaccnum

The Warkspace to use I

The Remate machine name< |D 0.00 >

The Paort to connect |2551

Dvatnralblama |

Check the definition of the remote machine in the delivery channel definition.

Specifying the Wrong Port Number

The following error occurs when the port number to connect to is specified
incorrectly:
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@ Error

MNarme

The Adapter Name

The Waorkspace to use

The Remaote machine name

The Port to connect

ProtocolMarme

An error occurred while attempting to log in with the selected delivery channel.
Javax.resource. ResourceException : Error in Connecting to server : Javax.resource.spl. CommException: Connection refused
Add Interaction: Login

Please enter the login information and select Apply. Information entered will be saved for the delivery channel and a login will be attempted.

|test

|accuunt

|194.50.22 88

[

Check the port number defined in the delivery channel. The default port number is
2552.

When the Connection with the 0S/390 Machine Is Down

If the delivery channel definitions are correct, the problem is probably with the
connection with the OS/390 machine itself. In this case, check that you have a
connection to the OS/390 machine in Oracle Studio.

For example you receive a connection timeout error when the daemon is not
running on the mainframe:

(}‘z) Errar

A6 Amor Beoiumsd whil

Jae reRnynce Fe s

Troubleshoo

ke altectin g 10 100 i with 9 2alechad dalkarg chanmsl

rcaEsceptan | S in Coneacling 10 Sedesr | R reaounce g CommEcerdnn Connecton dmad aul

ting the Daemon

A daemon runs on the OS/390 machine. The daemon is responsible for allocating a
server process for a client. The daemon resides in a single address space and is
executed as a started task.

The daemon authenticates clients, authorizes requests for a server process within a
certain server workspace and provides the clients with the required servers. When a
client requests a connection, the daemon allocates a server process to handle this
connection, and refers the client to the allocated process. This may be a new process
(dedicated to this client) or an already-started process. Further communication
between the client session and the server process is direct and does not involve the
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daemon. The daemon is notified when the connection ends and the process is either
killed or remains for use by another client

The daemon supports multiple server configurations called workspaces. Each
workspace defines accessible data sources, applications, environment settings,
security requirements and server allocation rules. The allocation of servers by the
daemon is based on the workspace that the client uses to access the data source.
Thus, a client can access a data source using one workspace, where a server process
is allocated from an existing pool of servers, or the client can access a data source
using a different workspace, where a new server process is allocated for each client
request.

The daemon loads configuration settings such as various operational parameters as
well as the list of workspaces accessible through the daemon.

See Also: Appendix C, "Daemon Configuration Settings" for
details about the configuration settings

Troubleshooting the daemon and the communication between Oracle Application
Server ProcessConnect and Oracle Connect for CICS. is performed using Oracle
Studio to monitor the daemon and server activity and control what happens to the
daemon and server processes.

This section contains the following sections:

= Starting the Daemon

= Shutting Down the Daemon

= Monitoring the Daemon During Runtime
= Daemon Logs

= Resolving Communication Errors

Starting the Daemon

If for any reason you shut down the daemon, as described in "Shutting Down the
Daemon" on page 6-6, you can restart the daemon as described in the following
task.

Note: The daemon is started on the OS/390 machine only. It
cannot be started remotely using Oracle Studio.
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Task: Starting the Daemon

Activate INSTROOT.USERLIB (ATTDAEMN) as a started task to invoke the daemon.
For example, in the SDSF screen enter the following:

'/s ATTDAEMN'
INSTROOT is the high-level qualifier where Oracle Connect for CICS. is installed.

See Also: "Starting the Daemon" on page 2-14 for details about
the ATTDAEMN JCL

Shutting Down the Daemon

If you need to shut down the daemon for any reason (for example, you want to
re-IPL the system), use Oracle Studio.

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Right-click the machine defined in "Configuring Oracle Connect for CICS" on
page 2-18 in the Configuration Explorer and choose Open Runtime
Perspective from the popup menu.

3. In the Runtime Explorer, right-click the machine and choose Shutdown
Daemon from the popup menu.

Monitoring the Daemon During Runtime

Use Oracle Studio to monitor the daemon during runtime.

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for CICS" on
page 2-18.

3. Right-click the machine defined in "Configuring Oracle Connect for CICS" on
page 2-18 in the Configuration Explorer and choose Open Runtime
Perspective from the popup menu.

You can manage the daemon by right-clicking the relevant node: daemon,
workspace or server process.

6-6 Oracle Application Server Integration Adapter for CICS Installation and User’s Guide



Troubleshooting the Daemon

Daemon (Machine) Options

Right-click the daemon to display the options available for it, including the ability
to display the daemon log.

The following options are available at the machine level:

Status - Checks the status of the daemon. The information about the daemon
includes the name of the daemon configuration used, the active client sessions
and logging information.

Reload Configuration - Reloads the configuration after any changes. Any
servers currently started are not effected by the changed configuration.

See Also: Appendix C, "Daemon Configuration Settings" for

details about the configuration settings
View Log - View the daemon log. For details see Daemon Logs on page 6-9.
View Events - For future use.

Daemon Properties - Displays information about the machine where the
daemon is running, such as the physical address and any username and
password needed to access the machine.

Shutdown Daemon - Shuts down the daemon on the machine.

Rename - Enables changing the name of the daemon displayed in the tree.
Remove - Removes the machine from the perspective tree.

Edit Daemon Configuration - Open the daemon editor to enable you to

reconfigure the daemon.

See Also: Appendix C, "Daemon Configuration Settings" for
details about the configuration settings

Refresh - Refreshes the display.

Workspace Options

Right-click a workspace to display the options available for the workspace,
including the ability to display the workspace log.

The following options are available at the workspace level:

Status - Checks the status of the workspace, whether it is available or not.
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Reload Configuration - Reloads the configuration of the workspace after any
changes. Any servers currently started are not effected by the changed
configuration.

View Log - View the log for all servers for the workspace. For details see
Daemon Logs on page 6-9.

View Events - For future use.

End Unused Servers - Ends all server processes for the workspace that are not
active. All available and unconnected servers are terminated and any connected
servers are marked and terminated on release.

Use this option when changes to the daemon configuration were made after
servers were started up. On the next operation, servers are restarted, based on
the new settings.

End All Servers - Ends all the active server processes for the specified
workspace, regardless of whether the server has an active client.

Edit Workspace Configuration - Open the daemon editor to enable you to
reconfigure the workspace.

See Also: Appendix C, "Daemon Configuration Settings" for
details about the configuration settings

Refresh - Refreshes the display.

Server Options

Right-click a server to display the options available for the server, including the
ability to display the server log.

The following options are available at the server level:

Status - Checks the status of the server. The information about the server
includes the server mode and the number of active client sessions for the server.

View Log - View the server log. For details see Daemon Logs on page 6-9.
View Events - For future use.
End - Ends the server process.

Refresh - Refreshes the display.
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Daemon Logs

Oracle Connect for CICS produces a number of logs that you can use to
troubleshoot problems. The daemon manages the following logs:

s The daemon log
= The workspace log
= The server process log

The Runtime Manager perspective of Oracle Studio provides a monitor for these
logs.

Display the required log by right-clicking the level you want (daemon, workspace
or server) and choosing the View Log option.

The Daemon Log Monitor

The daemon log displays activity between clients and the daemon, including clients
logging in and logging out from the daemon.
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[247] Login: xml client - 194,90.22.67:3732 (27-Feb-03 11:21:24)
[247] Login: xml client - 194,90,22.67:3732 (27-Feb-03 11:21:24)
trace --- > irpcServerDispatch: Dispatcing idrntidmn_nokify

[239] ClientxmlInit notification, 0, 194.90,22.67

trace --- > irpcServerDispatch: Dispatcing idmn:idmn_nokify

[239] ClientmlExit natification, 0, 194,90.22.67
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You can change the level of logging by clicking the Update Monitor button on the
toolbar. The following levels of logging are available:

none - The log displays who has logged in and out from the daemon.

error - The log displays who has logged in and out from the daemon and any errors

that have been generated.

debug - The log displays who has logged in and out from the daemon, any errors
that have been generated, and any tracing that has been specified in the daemon

configuration.

See Also:

"Daemon Logging" on page C-4 for details
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@Preferences x|

 none

" errar
% debug

Restore Defaults | Apply |
QK I Cancel |

The Workspace Log Monitor

The workspace log displays information about the workspace being used by the
client.

You can change the level of logging by clicking the Update Monitor button on the
toolbar. The following levels of logging are available:

none - The log displays who has connected and disconnected from the server
process.

error - The log displays who has connected and disconnected from the server
process and any errors that have been generated.

debug - The log displays who has connected and disconnected from the server
process, any errors that have been generated and any tracing that has been specified
in the daemon configuration.

See Also: "WS Logging" on page C-16 for details
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The Server Log Monitor

The server log displays activity between clients and the server process used by that
client to handle the client request.

;@;:Eonfiguration - Oracle Studio for Legacy Adapters

File Edit MNavigake Search Window Help
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Marme Machines
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You can change the level of logging by clicking the Update Monitor button on the
toolbar. The following levels of logging are available:

none - The log displays who has connected and disconnected from the server
process.

error - The log displays who has connected and disconnected from the server
process and any errors that have been generated.

debug - The log displays who has connected and disconnected from the server

process, any errors that have been generated and any tracing that has been specified
in the daemon configuration.
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See Also: "WS Logging" on page C-16 for details

The following table describes the log monitor toolbar buttons and their
functionality.

Table 6-1 Log Monitor Toolbar Buttons

Button Name Function
Resume Resumes monitoring the machine after the monitor has been
= suspended.

This button toggles with the suspend button.

Suspend Suspends the monitor.

1l

This button toggles with the resume button.

Update Monitor Updates the information being monitored.

Save as Enables specifying a name and location for saving the log.

: Clear view Clears the monitor view.
¥ |

Menu Displays a menu with the options available using the buttons.

Resolving Communication Errors

When Oracle Studio disconnects from the OS/390 machine, the machine is
displayed in Oracle Studio with an X in a red circle. If this situation occurs, try to
access the machine later.

The following table describes the various scenarios that may exist when Oracle
Application Server ProcessConnect disconnects from the OS/390 machine.
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Table 6-2 Scenarios When a Client Is Disconnected

Idle (Not Processing a Client

Scenario Request) Processing a Client Request
Explicit Disconnect The server is immediately notified of ~The server does not know that the client has
. .. the disconnect and either becomes disconnected and continues processing. When
(client explicitly . . . )
. available for use by another client or ~ processing completes, the server tries to reply to
closes connection . AP . . ’
terminates (if it is not reusable). the client and immediately gets an error that the

or client program . .
prog connection was lost. The server either becomes

terminates) available for use by another client or terminates (if
it is not reusable).
Abrupt Disconnect The server does not know that the The server does not know that the client has
. client has disconnected and remains  disconnected and continues processing. When
(client closed . . . .
in the idle state. processing completes, the server tries to reply to

without proper

shutdown or client After timing out based on whichever the client. After an interval (typically several

minutes, depending on the TCP/IP configuration),

e ot doemn warkansce | during which the TCP/IP subsystem refries
communication parameter or the TCP/IP KEEPALIVE Zi?g;;legs tt}}l1ea?:}e‘lsesil%sggi;hgeialcliegf{;?eoiiefrize’serthe
disconnected) parameter, the server is notified of the .

server that the connection has been closed. The

disconnect and either becomes
available for use by another client or
terminates (if it is not reusable).

server either becomes available for use by another
client or terminates (if it is not reusable).

To troubleshoot client/server communication problems, you need to be familiar
with the following;:

= The daemon configuration settings
= Oracle Connect for CICS security.

s The TCP/IP subsystem. Oracle Application Server Integration Adapter for
CICS uses TPC/IP for internal intermachine communications.

= System details, such as the account name and password of the administrator
account, the IP address of the machines involved and whether a portmapper is
being used.

Resolving Specific Errors
The following error messages relate to errors received from Oracle Connect.

C007: Server initialization failed.
Cause: The daemon failed to start its network service.
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Action: Check the processes being run on the system to see whether another
daemon or program is using the port specified in the delivery channel for the
adapter.

Action: Check the TCP/IP subsystem on the current machine by trying to ping
it or run ftp or telnet to or from it.

Action: Check whether the daemon has privileges to use the TCP/IP services
on the current machine with the port specified in the delivery channel for the
adapter.

C008: Setting server event handler failed.
Cause: Internal error.

Action: Contact Oracle Support Services.

C009: IRPCD process has been terminated by user request.

Cause: This message is informational only. The daemon successfully shut
down.

Action: No action required.

CO00A: Application %s not found.
Cause: The requested workspace does not exist.

Action: Check that the workspace defined in the delivery channel is also
defined in the daemon configuration on the OS/390 machine. Use the Status
option in the Runtime Manager perspective.

CO00B: Invalid IRPCD client context.

Cause: A non-Oracle Connect legacy adapter program is trying to connect to
the daemon.

Action: Check the processes and kill the relevant process with a system
command.

C00C: Daemon request requires a server login.

Cause: A non-Oracle Connect legacy adapter server or program was trying to
use a daemon service reserved for Oracle Connect legacy adapter servers.

Action: Check the processes and kill the relevant process with a system
command.

C00D: Daemon request requires a client login.
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Cause: The requested daemon requires a valid client login, which was not
supplied.

Action: Reissue the command and specify a username/password.

Action: Edit the user profile in Oracle Studio to specify a valid username and
password for the OS/390 machine.

See Also: "Setting Up Runtime User Access to the IBM OS/390
Machine" on page 2-25 for details

CO0E: Daemon request requires an administrator login.
Cause: The requested daemon service requires an administrative login.

Action: Edit the daemon security in Oracle Studio to specify a valid
administrator username and password.

See Also: "Daemon Security" on page C-7 for details

COOF: Anonymous client logins are not allowed.
Cause: The daemon is configured to require a valid username and password,
which were not supplied.

Action: Enable anonymous client access in daemon security in Oracle Studio.
See Also: "Daemon Security" on page C-7 for details

Action: Edit the user profile in Oracle Studio to specify a valid username and
password for the OS/390 machine.

See Also: "Setting Up Runtime User Access to the IBM OS/390
Machine" on page 2-25 for details

C010: Anonymous server logins are not allowed.
Cause: Internal error.

Action: Contact Oracle Support Services.

C011: Client has already timed out.
Cause: A server process was started on behalf of a client and the client has
timed out before the server completed its startup.

Action: Increase the Connect timeout value for the server workspace in the WS
Info. section of the daemon configuration.
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See Also: "WS Info." on page C-10 for details

C012: Invalid username/password.
Cause: Invalid username/password supplied when logging on to the daemon.

Action: See the daemon log file for the reason that the username/password
were not accepted.

Action: Edit the user profile in Oracle Studio to specify a valid username and
password for the OS/390 machine.

See Also: "Setting Up Runtime User Access to the IBM OS/390
Machine" on page 2-25 for details

Action: Make sure the daemon is started from an APF-authorized account that
is allowed to check for system usernames and passwords.

C014: Client connection limit reached - try later.
Cause: The maximum number of server processes for the workspace has been
reached, and none of the active servers could accept the client connection.

Action: Increase the number of sub-tasks per address space in the WS Server
section of the daemon configuration.

See Also: "WS Server" on page C-12 for details

Action: Try running the command later.

CO015: Failed to start server process.

Cause: The Oracle Connect for CICS daemon failed to start a server process or
the started server failed upon starting up.

Action: See the daemon and server log files for the reason the server did not
start. For example, you might receive an message with a reason specified in the
log file similar to the following: [C015] Failed to start NAVIGATOR
server process: No server account name defined for
anonymous client; code: -1601: SQL code: 0

Action: If you use impersonation, check the user profile on the client. Also see
C069.
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To set impersonation: APF authorize all the steplibs in the server
script on OS/390 machine. For example:

setprog... ada622-volume adavol
CICS.CICS.SDFHEXCI - p390dx
INSTROOT.load - 111111
INSTROOT.loadaut - 111111

INSTROOT is the high level qualifier where Oracle Connect for
CICS is installed.

In the WS Security tab of the Navigator workspace under the
daemon node in the Configuration perspective, check Use
specific workspace account the and clear the Workspace
account field of all values.

C016: Unexpected server state.
Cause: Internal error.

Action: Contact Oracle Support Services.

C017: Active daemon clients exist. Shutdown canceled.
Cause: One or more clients are still connected to the daemon.

Action: Wait until all the clients log off the daemon and then retry the
shutdown operation.

C019: Request is not granted because someone else is locking it.

Cause: A request to lock a resource managed by the daemon was denied
because another user has locked the resource.

Action: Wait for the other user to release the resource.

C01A: Lock %s not found.

Cause: A request to free a resource was denied because the caller did not lock
that resource (for example, another user shut down the daemon you are
working with).

Action: Contact Oracle Support Services.

C01B: Unexpected error in %s.
Cause: Internal error.

Action: Contact Oracle Support Services.
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C01C: Cannot update configuration without _APPLICATIONS lock.
Action: Contact Oracle Support Services.

C01D: Need to lock the application first.
Cause: Internal error.

Action: Contact Oracle Support Services.

CO1F: Cannot set configuration of a deleted application.
Cause: Internal error.

Action: Contact Oracle Support Services.

C020: Failed in looking up host name (gethostname())
Cause: Cannot connect to the remote machine.

Action: Check that the name specified for the machine in the delivery channel
is correct.

Action: Check that a domain name server (DNS) is available to look up the host
name.

Action: Check the TCP/IP subsystem on the machine by trying to ping it or
run ftp or telnet to or from it.

C021: Required variable %s not found
Cause: An environment variable required by the Oracle Connect for CICS
server was not defined when the server started up.

Action: Check whether the startup script makes any changes to the
environment variables used by Oracle Connect for CICS.

Action: Check whether the system-defined environment size is sufficiently
large for Oracle Connect for CICS.

C022: Server failed to connect and register with the daemon.

Cause: An Oracle Connect for CICS server started by the daemon was not able
to connect or register back with the daemon.

Action: Try to connect again.

Action: Increase the Connect timeout value for the server workspace in the WS
Info. section of the daemon configuration.

See Also: "WS Info." on page C-10 for details
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Action: Check that the startup script for the workspace launches the correct
version of Oracle Connect for CICS.

Action: Increase the number of sub-tasks per address space in the WS Server
section of the daemon configuration.

See Also: "WS Server" on page C-12 for details

C023: Call made to unregistered module %d.
Cause: Internal error.

Action: Contact Oracle Support Services.

C024: Failed to create a socket.
Cause: An error occurred within the TCP/IP subsystem.

Action: Check whether you have sufficient system privileges.

Action: Check the TCP/IP subsystem on the machine by trying to ping it or
run ftp or telnet to or from it.

C025: Failed to set socket option %s
Cause: An error occurred within the TCP/IP subsystem.

Action: Check whether you have sufficient system privileges.

Action: Check the TCP/IP subsystem on the machine by trying to ping it or
run ftp or telnet to or from it.

C026: Failed to bind server to port %s
Cause: An Oracle Connect for CICS server or daemon was not able to bind to
the specified port.

Action: Check whether another program is holding the port that was specified
in port specified in the delivery channel for the adapter.

Action: Check whether you have sufficient system privileges.

C027: Cannot create TCP service for %s
Cause: An error occurred within the TCP/IP subsystem

Action: Check the TCP/IP subsystem on the machine by trying to ping it or
run ftp or telnet to or from it.

C028: Unable to register (%s, %d, tcp)
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Cause: This error may happen when a portmapper is used (host:a) but the
portmapper is not available.

Action: Enable the portmapper.

Action: Avoid using the portmapper (by not using “:a” when starting the
daemon).

C029: Failed to create a server thread
Cause: Internal error.

Action: Contact Oracle Support Services.

CO02A: Server thread failed to start
Cause: Internal error.

Action: Contact Oracle Support Services.

C02B: Stopping the %s server - no client

Cause: A server that was started by the Oracle Connect for CICS daemon to
service a client did not get a client connection request within one minute. The
server terminates.

Action: In most cases, the client was terminated by a user request, so no
specific action is required.

Action: If no client can connect to the server, it may be that the server has
multiple network cards and the Oracle Connect for CICS daemon is not aware
of this. In this case, start the daemon with an IP address.

C02C: Unexpected event - a termination signal intercepted
Cause: Internal error.

Action: Contact Oracle Support Services.

C02D: Modified transport, context unknown/lost
Cause: Internal error.

Action: Contact Oracle Support Services.

CO02E: Call made to non-existing procedure %d

Cause: This error typically is caused by a client of a newer version calling an
old server.

Action: Verify that the client and server are using the same version of Oracle
Connect for CICS.
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CO2F: Corrupted arguments passed to procedure
Cause: Internal error.

Action: Contact Oracle Support Services.

C030: Unable to free arguments for %s() of %s
Cause: Internal error.

Action: Contact Oracle Support Services.

C031: Cannot register a non-module RPC %s
Cause: Internal error.

Action: Contact Oracle Support Services.

C032: An IRPCD program is required
Cause: Internal error.

Action: Contact Oracle Support Services.

C033: An IRPCD super-server is required for module events
Cause: Internal error.

Action: Contact Oracle Support Services.

C034: An invalid super-server module ID was specified, %d
Cause: Internal error.

Action: Contact Oracle Support Services.

C035: Out of memory
Cause: Not enough memory to service a client request.

Action: Increase process memory quota and/or add memory to the system.

C036: Failed to register RPC procedure module %s
Cause: Internal error.

Action: Contact Oracle Support Services.

C037: Failed to register an invalid RPC procedure number %x
Cause: Internal error.

Action: Contact Oracle Support Services.

C038: Cannot re-register RPC procedure number %x
Cause: Internal error.
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Action: Contact Oracle Support Services.

C042: Remote call to %s failed; %s
Cause: Remote call to API failed.

Action: Check the daemon log file.

Action: If necessary, change the level of detail written to the log file to help
resolve the problem.

See Also: "Daemon Logging" on page C-4 for details

C043: Failed to connect to host %s;%s
Cause: The remote host is not correctly defined to Oracle Connect for CICS or
is not working.

Action: Check the remote machine definition in the delivery channel for the
adapter.

Action: Check the daemon is up on the OS/390 machine. Use the Status option
in the Runtime Manager perspective.

Action: Check the network connection by trying to ping the host machine or
run ftp or telnet to or from it.

C045: Failed to create a service thread
Cause: The server failed to create a thread to service a client request.

Action: A system or process quota limit has been exceeded. Either increase the
quota or lower the Clients per server limit in the WS Info. section of the daemon
configuration.

See Also: "WS Info." on page C-10 for details

C047: %s out of memory

Cause: Not enough memory was available to Oracle Connect for CICS to
complete a requested operation.

Action: Kill unnecessary processes running on the server.
Action: Add more memory to the system.

Action: Allow the process to use more memory.
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Action: Limit the number of processes the daemon may start. If the demand for
servers exceeds the number of available servers, clients get a message telling
them the maximum number of servers has been reached and asking them to try
again later.

C066: Communication error with the server%s
Cause: Connection to the Oracle Connect for CICS daemon or server failed, or
an established session with a server has failed.

Action: Check the remote machine definition in the delivery channel.

Action: Check the daemon is up on the OS/390 machine. Use the Status option
in the Runtime Manager perspective.

Action: In case of a network problem, check the network connection by trying
to ping the host machine or run ftp or telnet to or from: it.

C067: Unexpected error occurred in server function %s
Cause: One of the server functions has exited with an exception (such as an
abend, or an Invalid Instruction).

Action: Contact Oracle Support Services.

C068: Fail to login daemon
Cause: The daemon is not running on the server machine.

Action: Use the Status in Oracle Studio Runtime Manager perspective to check
whether a daemon is running on the server

Action: Have the system administrator re-install Oracle Connect for CICS on
the server.

C069: Fail to get server
Cause: The Oracle Connect for CICS daemon on the server machine could not
start a server process to serve the client. A separate message provides more
detail on why the server process could not start.

Action: There are many possible causes of this error. If the cause is not clear
from the related message, see the Oracle Connect for CICS daemon log file on
the server

Action: The resolution to this error is highly dependent on the particular cause.
The following are some typical causes and resolutions.
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Action: Some process creation quota was exceeded. Either try again later or
increase the quota or the other relevant system resources.

Action: The server startup script failed.

Action: The username given is not allowed to use the requested server. Use an
authorized username.

Action: A limit on concurrent clients for a server has been reached. Try again
later.

Action: If you use impersonation, check the user profile on the client. Also see
C015, above.

CO06A: Failed to connect to server

Cause: The server assigned to the client did not accept the client connection. A
separate message provides more detail about why the server process did not
accept the connection.

Action: See the daemon and server log files for the reason that the server was
not available to accept its assigned client.

Action: If a multi-threaded server is used and many clients are trying to
connect to it at the same time, some may get a Connection Refused error if the
TCP/1IP request queue fills up.

C06B: Disconnecting from server

Cause: A network failure, or a server machine failure or a server program
failure caused the connection to abort. The currently active transaction is
aborted as well.

Action: Oracle Connect for CICS automatically tries to re-establish a connection
with a server upon the next SQL command issued against the server. Once the
network or machine failure is corrected, the connection to the daemon is
re-established automatically.

C070: Server failed to send reply to the client
Cause: Server terminated unexpectedly.

Action: Unless the client was intentionally stopped (for example, using
Control-C), contact Oracle Support Services.

C071: Connection to server %s was disconnected. Cursors state was lost.
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Cause: Either a network failure, a server machine failure or a server program
failure caused the connection to abort. The currently active transaction is
aborted as well.

Action: Normally, Oracle Connect for CICS automatically tries to create a new
session with the server upon the next attempt to access the server. If the
network and server are accessible, the next operation should succeed.
Otherwise, the network and/or server machine should be fixed before
connection can be resumed.

Action: In case of a server crash not related to callable user code, contact Oracle
support.

C072: Reconnect to server %s
Cause: This is an informational message only. The client has reestablished its
connection with the server.

Action: No action is required.

C073: The parameters passed to the admin server are invalid: %s
Cause: Internal error.

Action: Contact Oracle Support Services.

C074: No authorization to perform the requested operation (%s)
Cause: User/account has insufficient privileges.
Action: Grant administrative privileges to the user/account via the

Administrator parameter of the Daemon Security or WS Security sections in the
daemon configuration.

See Also: "Daemon Security" on page C-7 or "WS Security" on
page C-18 for details

C075: Failed to register daemon in the TCP/IP service table
Cause: Registration of the daemon in the TCP/IP services file has failed.

Action: Check that the account running the daemon has the permissions to
update the TCP/IP services file.

E001: Failed in lock/release operation

Cause: A lock or release operation of a global resource has failed. A separate
message provides more details. The separate message specifies the cause of this
error.
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Action: There are various causes for this error, including lack of sufficient
privileges or a system resource shortage.
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7

Configuring the 0S/390 Working
Environment

Oracle Connect for CICS includes a number of tuning parameters that can improve
performance. Specifically, the daemon can be configured to optimize
communication between the OS/390 machine and the client machine and the
binding environment can be tuned to optimize the way actual requests are handled.

This chapter contains the following sections:
= Configuring the Daemon for High Availability

s Configuring a Binding Environment

Configuring the OS/390 Working Environment 7-1



Configuring the Daemon for High Availability

Configuring the Daemon for High Availability

The daemon workspace is responsible for allocating server processes to clients. You
can configure a workspace to use a pool of server processes so that a server process
is always available for a client request. Use Oracle Studio to maintain daemon and
daemon workspace parameters to control the allocation of server processes and
their management in a pool.

You can also have a number of daemon workspace configurations. Thus, you can
tailor individual workspaces for use with different adapters.

The workspace that will be used is specified in the delivery channel, as described in
"Defining the Delivery Channel" on page 4-2.

Task: Adding a New Daemon Workspace Configuration

Use Oracle Studio to add a new daemon configuration. You can set up different
daemon configurations for different situations.

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. In the Configuration Explorer, click the + next to the machine defined in
"Configuring Oracle Connect for CICS" on page 2-18.

3. Click the + next to the Daemons node. The daemon configurations available on
this machine are listed.

4. Right-click IRPCD and select New Workspace from the popup menu.

5. In the New daemon workspace window, specify a name the new workspace
and optionally a description.

6. Specify whether you want it to have default settings or to copy the properties of
an existing workspace.

To copy the properties of an existing workspace, click the ellipsis button and
select the workspace from which you want to copy the properties.

Once the workspace is defined the daemon editor is displayed, showing the WS
Info tab.

Task: Editing the Workspace

You edit a workspace using the following tabs:
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= WS Info - Specifies general information including the server type, the
command procedure used to start the workspace, the binding configuration
associated with this workspace and the timeout parameters.

= WS Server Mode - Specifies workspace server information including features
that control the operation of the servers started up by the workspace and
allocated to clients.

= WS Logging - Specifies parameters for logging and the format to use for a log
file.

= WS Security - Specifies administration privileges, user access, ports available to
access the workspace and workspace account specifications.

= WS Governing - For internal use.

Task: Configuring the Server Mode

The server mode dictates how the daemon starts up new processes. The daemon
supports the following server modes:

Single Client - Each client receives a dedicated server process. The account in
which a server process runs is determined either by the client login information or
by the specific server workspace.

This mode enables servers to run under a particular user account and isolates
clients from each other (since each receives its own process). However, this server
mode incurs a high overhead due to process startup times and may use a lot of
server resources (since it requires as many server processes as concurrent clients).

Multi-Client - Clients share a server process and are processed serially.

This mode has low overhead since the server processes are already initialized.
However, because clients share the same process, they may impact one another,
especially if they issue lengthy queries.

The number of clients that share a process is determined by the Clients per
server limit (the maximum number of concurrent clients a server process for
the current workspace accepts).

Reusable - This is an extension of the single client mode. Once the client processing
finishes, the server process does not die and can be used by another client, reducing
startup times and application startup overhead.

This mode does not have the high overhead of single client mode since the servers
are already initialized. However, this server mode may use a lot of server resources
(since it requires as many server processes as concurrent clients).
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The other modes can be set so that the server processes are reusable by setting the
number of times a process can be reused with the Reuse limit value (the
maximum number of times a particular server process can be reused or how many
clients it can serve before it is retired). Reuse of servers enhances performance since
it eliminates the need to repeat initializations. However, reuse runs a risk of higher
memory leakage over time. The default for the Reuse 1limit field value is None,
indicating that no reuse limit is enforced.

Set the server mode in the WS Server tab of the daemon editor:

Workspace server mode reusable

—Reuse limit Clients per server limit
7 Mane ¢ Mone
% Maimum: IZD ﬁ  Maimum: ID ﬁ

—Server availability

Initial number of servers: I 1 ﬂ Minimum number of available servers: I 0 ﬂ
[~ et maximum rumber of servers: ID :I

—Resource limitations

Mumber of sub-tasks {05390 specific): I o i’
I Limit number of active servers: I a i’

—Server priority

% Use default priority

" Use priority specified: ID :I

Diaemaon Conkrol |Daem0n Logging |Daem0n Security |WS Infa. IWS Server ]WS Logging |WS Security |WS Governing |Source

When using any of the server modes you can specify a pool of server processes.
These server processes are started when the daemon starts and are maintained in a
pool. The server processes are available for use by new client requests from the
pool, saving initialization time. Instead of starting a new server process each time
one is requested by a client, the client receives a process immediately from the pool
of available processes. When the client finishes processing, this server process either
dies, or if reusable servers have been specified, it is returned to the pool.

You set up a pool of server processes by specifying the following parameters in the
WS Server tab.
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Initial number of servers - The number of server processes that are prestarted for
this workspace when the daemon starts up. These are available for use by new
client processes with minimal initialization time. Instead of starting a new server
process each time one is requested by a client, the daemon immediately allocates (to
the client) a server from a pool of available servers. When the number of available
server processes drops below the value specified in the Minimum number of
available servers field, the daemon again starts server processes until the
specified number of available servers is reached. The default for this parameter is 0,
meaning that no servers are prestarted for this workspace.

Minimum number of available servers - The minimum number of server processes
in the prestarted server's pool before the Oracle Connect daemon resumes creating
new server processes (up to the number specified in the Initial number of
servers field value, described above). If this parameter is set to a value greater
than that of the Initial number of servers field value, the daemon considers
the value to be the same as the value specified in the Initial number of
servers field. In this case, a new server process is started and added to the pool
each time a server process is removed from the pool and allocated to a client). The
default for this parameter is 0, meaning that new servers are created only when
there are no other available servers.

Set maximum number of servers - The maximum number of available server
processes pooled for this workspace. If the server is reusable, once a client
disconnects from the server, the daemon returns the server to the pool of available
servers. If the limit is reached, excess server processes are discarded.

Number of sub-tasks - The number of sub-tasks for a server that are prestarted for
this workspace when the daemon starts up. In addition to setting up a pool of
server processes as described above, you can set additional server processes as
sub-tasks by specifying this parameter. Thus, setting 10 servers and 10 prestarted
sub-tasks results in 100 tasks started (10 sub-tasks for each process).

Configuring a Binding Environment
Each binding configuration includes the following;:

» Environment settings, which are used to configure the environment used by
any of the adapters defined in the binding

= Application adapters on the current machine

= Inbound queues for adapters on the OS/390 workstation machine. (Inbound
queues are referred to as events in Oracle Studio)
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Configuring data sources, adapters and inbound queues are described in Chapter 3,
"Modeling Interactions for Oracle Application Server Integration Adapter for CICS".
The following section describes the environment settings.

Task: Setting a Binding Environment

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. In the Configuration Explorer, click the + next to the machine defined in
"Configuring Oracle Connect for CICS" on page 2-18.

3. Click the + next to the Bindings node. The binding configurations available on
this machine are listed.

4. Right-click NAV and select Edit Binding.
5. In the Properties tab edit the environment settings as needed.

To edit an environment setting, expand the property category and click the value to
edit. The binding environment is divided into the following categories:

= comm Category

= debug Category

= miscellaneous Category
= odbc Category

= oledb Category

= optimizer Category

= queryProcessor Category
= transactions Category

= tuning Category

comm Category
The following parameters define communication buffers:

comCacheBufferSize - The size of a memory buffer on a client, which is used by the
Oracle Connect client/server to store read-ahead data. The default is 200000 bytes.

comMaxSocketSize - The maximum bytes that can be written in one chunk on a
socket. The default is -1 (no limitation).
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comMaxXmlInMemory - The maximum size of an XML document held in memory.
The default is 65535 bytes.

comMaxXmlSize - The maximum size of an XML document passed to another
machine. The default is 65535 bytes.

debug Category

The following parameters define debugging and logging operations.

acxTrace - When set to "true", the input xml sent to the backend adapter and the
output xml returned by the backend adapter, are written to the log.

analyzerQueryPlan - For internal use.
gdbTrace - For internal use.

generalTrace - When set to "true", logs general trace information. The default writes
only error messages to the log.

logFile - The high-level qualifier of the log file for messages. The following types of
message are written to the log:

= Error messages

s Trace information and information about the query optimization strategy if
generalTrace is set to "true"

oledbTrace - For internal use.
optimizerTrace - For internal use.
queryWarnings - For internal use.

traceDir - For internal use.

miscellaneous Category

The following parameters define miscellaneous operations, including national
language support (NLS) and the directory where temporary files are written.

codepage - For use with National Language Support (NLS) to identify the codepage
for the workspace.

See Also: Appendix E, "National Language Settings"

cvtSeverityLevel - The data type conversion policy when a conversion error occurs:

s 0 (Default) - The data in the output column will be a null or empty value.
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s 1-The data in the output column will be a null or empty value and the
error is reported to the log.

= 2- Anerror is reported and processing stops.
edit - For internal use.

language - Identifies the application language. A default codepage is selected based
om the value specified for this parameter.

See Also: Appendix E, "National Language Settings"

nisString - Specifies the codepage used by a field whose data type is defined as
"nlsString". You use this for a field whose codepage is other than that of the
machine’s codepage. This parameter includes the following values:

= The name of the codepage.

= Whether the character set reads from right to left (as in middle eastern
character sets). The default is "false".

tempDir - The directory where temporary files are written, including the temporary
files created for use by hash joins and for sorting files. The default is the current
high-level qualifier.

year2000Policy - Determines the way 2-digit years are converted into 4-digit years.
When the parameter year2000Policy is not set, or when it is set to a value outside
the range of values defined for the policy, as described below, a default value of 5
and the Sliding Base Year policy is used. Two policies are provided:

Fixed Base Year - year2000Policy is set to a value greater than, or equal to 1900.
In this case, the value of year2000Policy is the first 4-digit year after 1900 that
can be represented by a 2-digit year. For example, if year2000Policy is set to
1905, the years 2000->2004 will be represented by 00->04. All other 2 digits will
map to 19xx.

This solution is most appropriate if there is live data at the low end (close to the
year 1900), which the user wants to keep with the current 2-digit format.

The user will probably change the base date only after ensuring that these old
dates have been deleted from the data source.

Sliding Base Year - year2000Policy is set to a positive value less than 100. In this
case, the value of year2000Policy represents the number of years ahead of the
current year that can be represented by a 2-digit number. With each passing
year the earliest year that can be represented by a 2-digit number changes to a
year later.

7-8 Oracle Application Server Integration Adapter for CICS Installation and User’s Guide



Configuring a Binding Environment

odbc Category

The odbc parameters are for internal use.

oledb Category

The oledb parameters are for internal use.

optimizer Category
The optimizer parameters are for internal use.

queryProcessor Category

The queryProcessor parameters are for internal use.

transactions Category
The transactions parameters are for internal use.

tuning Category

The tuning parameters are for internal use.
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The Oracle Connect CICS Interaction
Metadata Definitions

Oracle Studio includes a wizard to help define the adapter inbound and outbound
interactions and input and output structures used for these interactions. The
interactions and input and output structures are maintained as metadata in the
Metadata perspective of Oracle Studio.

This appendix contains the following section:

» Interaction Metadata for the Adapter
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Interaction Metadata for the Adapter
Use Oracle Studio to maintain the metadata for the CICS adapter.

1.

o o & W

7.

On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

Select the machine defined in "Configuring Oracle Connect for CICS" on
page 2-18.

Click the + next to the Bindings node.
Click the + next to the NAV binding node.
Click the + next to the Adapters node to display the adapters.

Right-click the CICS adapter in the Configuration Explorer and choose Edit
Metadata to open the Metadata perspective.

Right-click the adapter in the Metadata Explorer and choose Edit definition.

The metadata editor opens, displaying the General tab, with general table details.
The following tabs are used to edit the metadata:

General Tab
Interaction Tab
Schema General Tab

Schema Record Tab

The following tab provides an XML representation of the metadata:

General Tab

Source Tab

Use the General tab to maintain information generally describing the adapter and
the connection to it.
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—Details

Adapter Definition Mame: | CICS_ADAPTER

Description: IJ
4

3
o

Wersion; I

Yendar: |

—Connection

Authentication Mechanism: I j Max Request Size: I
IMax Active Connections: I Max Idle Timeout: I

—Adapter Specifications

Propert: | Yalue

General ]Interaction |Sehema General | Schema Record | Source

The General tab has the following fields:

Adapter definition name - The name of the adapter definition.

Description - An identifying description of the adapter.
Version - The adapter version.
Vendor - The vendor which the adapter came from.

Authentication mechanism - The authentication to access the adapter. The
available mechanisms are:

= kerbv5
u none
= basic-password

Max request size - The maximum size in bytes for an XML request or reply.
Larger messages are rejected with an error.

Max active connections - The maximum number of simultaneous connections
for an adapter (per process).

Max idle timeout - The maximum time, in seconds, that an active connection
can stay idle. After that time, the connection is closed.
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Adapter Specifications - Adapter-specific properties.

Interaction Tab

Use the Interaction tab to define the general details of the interaction in addition to
its input and output definitions.

—Details

Interaction Mame: | Interactiond

Description: ;I
-
A 3

IMode: Isync-send—receive j

—Inputfoutput Definitions

Input Record: IInteractionD_._EMP-RECORDS j Edit...l
Output Record: IInteractionD_._EMP-RECORDS j Edit ... |

—Interaction Specific Parameters

Propert: | Yalue |

General lInteraction ]Schema General | Schema Recard | Source

The Interaction tab has the following fields:
Interaction name - The name of the interaction.
Description - A descriptive identifier for the interaction.
Mode - The interaction mode:

= sync-send-receive - The outbound interaction sends a request and expects
to receive a response.

= sync-send - The outbound interaction sends a request and does not expect
to receive a response.

= sync-receive - The outbound interaction expects to receive a response.

= async-send - The inbound interaction sends a request and does not expect
to receive a response.
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Input record - Identifies an input record.

Output record - Identifies an output record for the results of an outbound
interaction.

Interaction Specific Parameters - Defines the property and value of parameters
specific to the interaction. For each interaction you must specify the following

property:
program - The name of the program that is executed for the interaction.

Schema General Tab

Use the Schema General tab to define the general details of the input and output
record structures for the interaction.

Details

Schema Mame: I

Wersion: I

Header: I

General | Interaction lSchema General ]Schema Record | Source

The Schema General tab has the following fields:
Schema name - The name of the adapter.
Version - The schema version.

Header - A C header, file to map between the data structure and the adapter.
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Schema Record Tab

Use the Schema Record tab to define the input and output record structures for the

interaction.
—Fields List

Marmne | Type | Length | New Fieldl

[l Interactiond_,_EMP-RE... Record
EMP-S5NS string Delete |
EMP-MAMES EMP-RECORDS_, _EMP-N...
EMP-TELEPHOMES string
EMP-ADDRS EMP-RECORDS_. _EMP-4...

— Specifications

Propett: | Value |

General |Interaction | Schema General lSchema Record ]Source

The Schema Record tab has the following fields:
The Fields List defines single data items within a record.

Name - The name of the field.
Type - The datatype of the field. The following are valid datatypes:
Binary
Boolean
Byte
Date
Double
Enum
Float
Int

A-6 Oracle Application Server Integration Adapter for CICS Installation and User’'s Guide



Interaction Metadata for the Adapter

Long
Numeric[(p[,s])]
Short

String

Time

Timestamp

See Also: Appendix B, "Datatype Support” for details about the
mapping from COBOL datatypes to Oracle Connect for CICS
datatypes

Length - The size of the field including a null terminator, when the
datatype supports null termination (such as the cstring datatype).

Use the Specifications box to specify field properties.

Source Tab
The Source tab displays the XML representation of the adapter metadata.
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Datatype Support

The Oracle Application Server Integration Adapter for CICS supports a number of
datatypes that are used when defining metadata in Oracle Studio. The datatypes are
mapped from the COBOL datatypes during the import procedure.

Note: The mapping of datatypes between Oracle Application
Server Integration Adapter for CICS and Oracle Application Server
ProcessConnect is performed internally by Oracle Connect for
CICS.

This appendix contains the following section:

s Datatype Mapping
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Datatype Mapping

The COBOL datatype COMDP, in the table is an abbreviation for, and synonymous
with, COMPUTATIONAL. Square brackets ([ ]) denote optional qualifiers for some
COBOL compilers, which may not be allowed for other COBOL compilers.

Table B-1 Datatype Mapping: COBOL and Oracle Connect for CICS

COBOL Datatype Oracle Connect Datatype
BINARY (with fractional data) string
BINARY (without fractional data) int
COMP (with fractional data) string
COMP (without fractional data) int
COMP-2 double
COMP-3 string
COMP-4 (with fractional data) string
COMP-4 (without fractional data) int
COMP-5 (with fractional data) string
COMP-5 (without fractional data) int
COMP-X (with fractional data) string
COMP-X (without fractional data) int
INDEX int
[SIGN [IS]] LEADING string
[SIGN [IS]] LEADING SEPARATE [CHARACTER] string
NATIVE-2 int
NATIVE-4 int
NATIVE-8 string
PACKED-DECIMAL string
POINTER int
[SIGN [IS]] TRAILING string

[SIGN [IS]] TRAILING SEPARATE [CHARACTER] string
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Daemon Configuration Settings

The daemon runs on the OS/390 machine and is responsible for allocating a server
process for a client. The daemon resides in a single address space and is executed as
a started task. When started, the daemon loads configuration settings such as
various operational parameters as well as the list of workspaces accessible through
the daemon.

The daemon configuration is managed using Oracle Studio. Daemon configuration
is divided into the following groups:

This appendix contains the following sections:
= Daemon Control

= Daemon Logging

= Daemon Security

= Workspaces
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Daemon Control

The Daemon Control section specifies various control options.

The Daemon Control section is accessed as follows:

1.

On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

Select the machine defined in "Configuring Oracle Connect for CICS" on
page 2-18.

Right-click the machine and choose Open Runtime Perspective.

Right-click the daemon in the Runtime Explorer and choose Edit Daemon
Configuration. The Daemon Control tab opens.

After making changes to the daemon, right-click the daemon and choose
Reload Configuration.

Note: You can also change daemon settings in the using the
Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Right-click the daemon and
choose Edit Daemon.

Changes made to the daemon configuration are only implemented
after the configuration is reloaded using the Reload Configuration
option in the Runtime Manager.
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—General

[~ Automatically recaver from Failure  Maximurn %ML request size: I 65654 ﬁ

Maimum XML in memory: |65654 :I Default language: I 'l

r—Timeout parameters

Call tirmeout: |6U :I Conneck bimeout: ISU :I Clignt idle timeout: IU :I

r—Manikoring
Iaximumm number of blocks: I 100 :I Maximum number of messages stored in a single block: | 100 :I

Daemon Conkrol ]Daemon Logging |Daemon Security |Source

The following fields are displayed:

Automatically recover from failure - The daemon restarts automatically if it fails
for any reason (any error that causes the daemon process to terminate, such as
network process lost or the CPU running the daemon crashes and the backup
daemon is defined on another CPU). All available and unconnected servers are
terminated and any connected servers are marked and terminated on release. Also

the backup starts a backup for itself.

The backup appends a new log file to the log of the original daemon, adding a line

indicating that a backup daemon was started.

Maximum XML request size - The maximum number of bytes that the daemon

handles for an XML document.

Maximum XML in memory - The maximum amount of space reserved for the XML

in memory.

Default language - The language that the daemon supports. This setting is used
when working with a client with a code page different from the server code page.

Call timeout - The timeout period for short calls for all daemons. The definition of a
short call is a call that should be completed in a few seconds. For example, most
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calls to a database such as DESCRIBE should be completed in a few seconds as
opposed to call like a GETROWS call, which can take a long time. In heavily loaded
or otherwise slow systems, even short calls such as calls to open a file, may take a
significant amount of time. If a short call takes more than the specified time to
complete, the connection is aborted. The default value for this parameter is 60
seconds. Values of less than 60 seconds are considered to be 60 seconds.

Specifying the timeout in a workspace overrides the value set in this field for that
workspace.

Connect timeout - The time the client waits for a daemon server to start. If the
daemon server does not start within this period, the client is notified that the server
did not respond. The value specified for this parameter serves as the default
timeout for all the workspaces listed in the daemon configuration. The default value
for this parameter is 60 seconds.

Specifying the timeout in a workspace overrides the value set in this field for that
workspace.

Client idle timeout - The maximum amount of time any daemon client may be idle
before the connection with the server is closed.

Specifying the timeout in a Workspace overrides this setting for that workspace.

Daemon Logging

The Daemon Logging section defines the daemon log file settings, the log file
structure and the location where the log is saved. In addition it defines the data that
is logged and traced in the file.

Note: By default the log entries are written to SYSOUT for the
daemon process.

The Daemon Logging section is accessed as follows:

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for CICS" on
page 2-18.

3. Right-click the machine and choose Open Runtime Perspective.
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4. Right-click the daemon in the Runtime Explorer and choose Edit Daemon
Configuration.

5. Choose the Daemon Logging tab.

6. After making changes to the daemon, right-click the daemon and choose
Reload Configuration.

Note: You can also change daemon settings in the using the
Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Right-click the daemon and
choose Edit Daemon.

Changes made to the daemon configuration in the way are not
implemented. They are only implemented after the configuration is
reloaded using the Reload Configuration option in the Runtime
Manager.

Daeman log file location:

—Logging options

[T Client regquests for server I Daemon RPC Function calls

[~ administration requests For Daemaon ™ Daemon inkernal operations
W Daemon operations [ Trace infarmation

[ Daemon logins ™ Display host and darnain name

—Trace options

[ Mo timeout " Extended RPC trace
[ calltrace I Svstem trace

[~ RPC trace r Timing

™ Sockets

Server |og filename Format:

Diaemaon Conkrol lDaemon Logging IDaemon Security |Source

The following fields are displayed:
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Daemon log file location - Where the daemon produces its log data if you want the
data written to a file instead of SYSOUT for the daemon process. The full path must
be specified.

Logging options - Specifies what tracing is performed.

Client requests for server - Logs client requests for server activations; this
provides logging of the process IDs of the started servers along with the
location of the log files.

Administration requests for daemon - Logs all of the administration requests
for the daemon.

Daemon operations - Logs all of the daemon operations.
Daemon logins - Logs daemon logins.

Daemon RPC function calls - Log all daemon RPC function calls.
Daemon internal operations - Log daemon internal operations.
Log trace information - Logs low-level RPC operations.

Display host and client domain name - Whether the client host and domain
name are logged rather than the client IP address. The default is false.

Trace options - Specifies what tracing is performed.

No timeout - Disables the standard RPC timeouts, setting them to a long
duration (approximately an hour) to facilitate debugging.

Call trace - Generates a message in the server log file for each RPC function
called. This is useful for troubleshooting the server.

RPC trace - Enables debugging messages on the server.
Sockets - Generates a message in the server log file for each socket operation.

Extended RPC trace - Generates a verbose message in the server log file for
each low-level RPC function called. This is useful for troubleshooting the server.

System trace - Generates system-specific tracing of various operations.
Timing - Generates a timestamp for every entry to the server log file.

Server log filename format - The name of the server log file if you want the data
written to a file instead of SYSOUT for the server process.

The following tokens can appear in the log file template and will be replaced
accordingly:
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%A - workspace name
%D - date (yymmdd)
%I - instance number of the given workspace server

%L - the path to INSTROOT . TMP. If you specify a file name without this path, the
file is created under INSTROOT. TMP . £11ename, where INSTROOT is the high-level
qualifier where Oracle Connect for CICS is installed.

%P - server's process ID
%T - time (hhmmss)
%U - server's account name (username)

For example, a log file template $L . ATTSRVR%I can produce a log file such as:
INSTROOT.TMP.ATTSRVR5, where INSTROOT is the high-level qualifier where
Oracle Connect for CICS is installed.

Daemon Security
The Daemon Security section is used for the following;:
» To grant administration rights for the daemon
= To determine access to the machine
The Daemon Security section is accessed as follows:

1.  On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for CICS" on
page 2-18.

3. Right-click the machine and choose Open Runtime Perspective.

4. Right-click the daemon in the Runtime Explorer and choose Edit Daemon
Configuration.

5. Choose the Daemon Security tab.

6. After making changes to the daemon, right-click the daemon and choose
Reload Configuration.
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Note: You can also change daemon settings in the using the
Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Right-click the daemon and
choose Edit Daemon.

Changes made to the daemon configuration in the way are not
implemented. They are only implemented after the configuration is
reloaded using the Reload Configuration option in the Runtime
Manager.

— Administrator privileges
* allusers

" Selected users only

Add|user |
Add group |
Rename |
Remaove |

—Machine access
V' allows anorymous login W Cached passward

Encryption methods I *

Daemon Conkrol |Daemon Logging IDaemon Security ]Source

The following fields are displayed:

Administrators privileges - Identifies the users (accounts) allowed to perform
administrative tasks (tasks that require administrative login).

All users - Anyone can access the daemon and change the settings.

Selected users only - The names of users (accounts) and groups that can be
administrators.'
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Note: If a user is not specified, the account from which the
daemon was started is considered the administrator. Note that the
daemon does not require the user to log in to the account on the
system, but to log in to the daemon using the account name and
password.

Machine access - Manages access to the machine.

Workspaces

Anonymous login allowed - Whether workspaces allow anonymous logins
(without user name/password entries). For the optimal level of security, keep
this option unchecked and define a username for the Daemon Administrators
parameter.

If unchecked, no workspace can have an anonymous client. If checked, a
particular workspace allows anonymous clients.

Cached passwords - Enables login passwords to be cached. This enhances
performance by reducing login times for future connections from the same
client in a session.

Encryption methods - The encryption method being used to send information
across the network. The default is an asterisk (*), meaning that all methods are
acceptable. If an encryption method is specified, it must be used. The RC4 and
DES3 protocols are currently supported.

A daemon can include a number of workspaces. A workspace defines the server
processes and environment that are used for the communication between the client
and the server machine for the duration of the client request. Each workspace has
its own definition. The workspace definition is divided into the following groups:

WS Info.
WS Server
WS Logging
WS Security

1 The name is prefixed with '@, to utilize the operating system GROUP feature.
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WS Info.

WS Governing - for internal use

Warning: You must not delete the Navigator workspace.

Using WS Info. you specify the features that control the operation of the
workspace: the server type, the command procedure used to start the workspace
and the binding configuration associated with this workspace.

The WS Info. section is accessed as follows:

1.

On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

Select the machine defined in "Configuring Oracle Connect for CICS" on
page 2-18.

Right-click the machine and choose Open Runtime Perspective.
Drill-down the daemon to display the workspaces in the Runtime Explorer.

Right-click the workspace and choose Edit Workspace Configuration. The WS
Info. tab opens.

After making changes to the daemon, right-click the daemon and choose
Reload Configuration.

Note: You can also change workspace settings in the using the
Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Drill-down the daemon to
list the workspaces. Right-click the workspace and choose Edit
Workspace.

Changes made to the daemon configuration in the way are not
implemented. They are only implemented after the configuration is
reloaded using the Reload Configuration option in the Runtime
Manager.
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Workspace name: | MAYVIGATOR
Description: Cracle Conneck Server ;I
-
< v
Startup scripk: | ATTSRYR.AY
Server bype: Inative

Lef Lef

“Workspace binding name: I

“Workspace database name: I

Clignt idle timeout: IU :I Conneck bimeout: |6U :I

|'Timeout paramekters

Diaemaon Conkrol |Daem0n Logging |Daem0n Security lWS Infa. JWS Server |WS Logging |WS Security |WS Governing |Source

The following fields are displayed:

Workspace name - The name used to identify the workspace.

Note: The default configuration includes the default Navigator
Workspace. This workspace is automatically used if a workspace is
not specified as part of the connection settings.

Description - A description of the workspace.

Startup script - The full pathname of the script that starts the workspace server
processes. The script specified here must always activate the nav_login procedure
and then run the server program (svc). If you do not specify the directory, the
startup procedure is taken from the directory where the daemon resides. Oracle
Connect for CICS includes a default startup script, which it is recommended to use.

Specify only the script name, since the server is activated as a started task.

Note: The installation includes a default startup script: ATTSRVR.
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WS Server

Server type - For internal use only.
Workspace binding name - For internal use only.

Timeout parameters - The time the client waits for the workspace server to start. If
the workspace server does not start within this period, the client is notified that the
server did not respond. Specifying the timeout here overrides the default setting,
specified in the Control section.

See Also: "Daemon Control" on page C-2 for details about the
Control section

Client idle timeout - The maximum amount of time a workspace client can be
idle before the connection with the server is closed.

Connect timeout - The time the client waits for a workspace server to start. If
the workspace server does not start within this period, the client is notified that
the server did not respond. The value specified for this parameter serves as the
default timeout for all the workspaces listed in the daemon configuration. The
default value for this parameter is 60 seconds.

Using WS Server, you specify the features that control the operation of the servers
started up by the workspace and allocated to clients. For example, you can
configure the workspace to start up a number of servers for future use, prior to any
client request, instead of starting each server when a request is received from a
client.

The WS Server section is accessed as follows:

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for CICS" on
page 2-18.

Right-click the machine and choose Open Runtime Perspective.
Drill-down the daemon to display the workspaces in the Runtime Explorer.
Right-click the workspace and choose Edit Workspace Configuration.
Choose the WS Server tab.

N o g 0

After making changes to the daemon, right-click the daemon and choose
Reload Configuration.
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Note: You can also change workspace settings in the using the

Configuration Explorer, by selecting a machine and drilling-down

the list until the daemon is displayed. Drill-down the daemon to
list the workspaces. Right-click the workspace and choose Edit

Workspace.

Changes made to the daemon configuration in the way are not

implemented. They are only implemented after the configuration is

reloaded using the Reload Configuration option in the Runtime

Manager.

“Workspace server mode

—Reuse limit
" None

£ Masinmurn: I 20 ﬂ

Clients per server limit
% None

7 Masinmurn: I 1} ﬂ

—Server availability

[~ et maximum rumber of servers: I a ﬂ

Initial number of servers: I 1 :I Minimurm number of available servers: IU :’

—Resource limitations

Mumber of sub-tasks (05/390 specific): I 1] i’
[ Limit number of active servers: I a i’

—Server priatity

% Use default priority

' Use priority specified: ID :I

Daemaon Conkrol |Daem0n Logging |Daem0n Security |WS Infa. IWS Server ]WS Logging |WS Security |WS Governing |Source

The following fields are displayed:

Workspace server mode - The type of new server processes that the daemon starts
up. The daemon supports the following server modes:

Single client - Each client receives a dedicated server process. The account in
which a server process runs is determined either by the client login information
or by the specific server workspace.
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This mode enables servers to run under a particular user account and isolates
clients from each other (since each receives its own process). However, this
server mode incurs a high overhead due to process startup times and can use a
lot of server resources (since it requires as many server processes as concurrent
clients).

Multi-client - Clients share a server process and are processed serially. This
mode has low overhead since the server processes are already initialized.
However, because clients share the same process, they can impact one another,
especially if they issue lengthy queries.

The number of clients that share a process is determined by the "Clients per
server limit" field.

Multi-threaded - For internal use only.

Reusable - An extension of single-client mode. Once the client processing
finishes, the server process does not die and can be used by another client,
reducing startup times and application startup overhead.

This mode does not have the high overhead of single-client mode since the
servers are already initialized. However, this server mode can use a lot of server
resources (since it requires as many server processes as concurrent clients).

Note: The other modes can be set so that the server processes are
reusable. The number of times a process can be reused is controlled
by the Reuse limit field value.

Reuse limit - The maximum number of times a particular server can be reused. A
one-client server can be reused after its (single) client has disconnected. Reuse of
servers enhances startup performance because it avoids the need to repeat
initialization. The default for this field is none (0), indicating that server reuse is
unlimited. This parameter is enabled only if the server mode value is
Multi-client or reusable.

Clients per server limit - The maximum number of clients a server process for the
current workspace accepts. The default for this field is none (0), indicating that the
number of clients per server is unlimited. This field is enabled only if the server
mode valueis Multi-client.

Server availability

Initial number of servers - The number of server processes that are prestarted
for this workspace when the daemon starts up. When the number of available
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server processes drops below the value specified in the Minimum number field
(see below), the daemon again starts server processes until this number of
available server processes is reached. The default for this field is 0.

Minimum number - The minimum number of server processes in the
prestarted pool before the daemon resumes creating new server processes (to
the value specified in the Initial number of servers field). If this field is set to a
value higher than the Initial number of servers field, the daemon uses the
value specified in the Initial number of servers field. The default for this field
is 0.

Set maximum number of servers - The maximum number of available server
processes. Once this number is reached, no new nonactive server processes are
created for the particular workspace. For example, if a number of server
processes are released at the same time, so that there are more available server
processes than specified by this field, the additional server processes above this
value are terminated. The default for this field is 0, meaning that there is no
maximum.

Resource limitations

Number of subtasks - The number of subtasks for a server that are prestarted
for this workspace when the daemon starts up. Thus, setting 10 prestarted
servers and 10 subtasks results in 100 tasks started (10 subtasks for each
process).

Limit number of active servers - The maximum number of active server
processes (either available or in use). Once reached, no new server processes
will be created for the particular workspace and client connections would be
rejected if there is no available server to accept them. Once the number of active
servers drops below the maximum (for example, a client disconnects from a
server and the server terminates), new servers can again be started. If the value
of this field is set to a nonzero value lower than the value for the Initial number
of servers field, the daemon assumes it is set to the same value as the Initial
number of servers field. The default for this field is 0, meaning that no
maximum is enforced.

Server Priority - The priority for servers. For example, a workspace for applications
with online transaction processing can be assigned a higher priority than a
workspace that requires only query processing.

Use default priority - Sets the priority as 0. There is no specific priority for this
workspace.

Use priority - Enables setting the priority.
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WS Logging

Using WS Logging you specify parameters to log that occur with the workspace
server process.

The WS Logging section is accessed as follows:

1.

N o g e

On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

Select the machine defined in "Configuring Oracle Connect for CICS" on
page 2-18.

Right-click the machine and choose Open Runtime Perspective.
Drill-down the daemon to display the workspaces in the Runtime Explorer.
Right-click the workspace and choose Edit Workspace Configuration.
Choose the WS Logging tab.

After making changes to the daemon, right-click the daemon and choose
Reload Configuration.

Note: You can also change workspace settings in the using the
Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Drill-down the daemon to
list the workspaces. Right-click the workspace and choose Edit
Workspace.

Changes made to the daemon configuration in the way are not
implemented. They are only implemented after the configuration is
reloaded using the Reload Configuration option in the Runtime
Manager.
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Trace options

[ Mo timeout ™ Extended RPC trace
[T Calltrace I Syskem trace

l_ RPC trace |_ Timing

™ sockets

Diaemaon Conkrol |Daem0n Logging |Daem0n Security |WS Infa. |WS Server | WS Logging | WS Security |WS Governing |Source

The following fields are displayed:
Trace options - Specifies what tracing is performed.

No timeout - Disables the standard RPC timeouts, setting them to a long
duration (approximately an hour) to facilitate debugging.

Call trace - Generates a message in the server log file for each RPC function
called. This is useful for troubleshooting the server.

RPC trace - Enables debugging messages on the server.

Sockets - Generates a message in the server log file for each socket operation.
This is useful for troubleshooting client/server communication - providing a
detailed trace of every client/server communication.

Extended RPC trace - Generates a verbose message in the server log file for
each low-level RPC function called. This is useful for troubleshooting the server.

System trace - Generates operating system-specific tracing.
Timing - Generates a timestamp for every entry to the server log file.

Specific log file format - Defines the name and location of the server log file if you
want the data written to a file instead of SYSOUT for the server process. The
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parameter must specify the full pathname. If no directory information is provided
for the log file, it will be located in the login directory of the account running the
server.

The following tokens can appear in the log file template and will be replaced
accordingly:

%A - workspace name
%D - date (yymmdd)
%I - instance number of the given workspace server

%L - the path to INSTROOT . TMP. If you specify a file name without this path, the
file is created under INSTROOT. TMP . filename, where INSTROOT is the high-level
qualifier where Oracle Connect for CICS is installed.

%P - server's process ID
%T - time (hhmmss)

%U - server's account name (username)

Note: Unless this parameter is specified, the log entries are
written to SYSOUT for the job specified in the Workspace startup
parameter.

WS Security

Using WS Security you specify the level of security at the workspace level, as
opposed to the daemon level, which is set in the Security section of the daemon.

See Also: For details about the Security section, see "Daemon
Security” on page C-7

The WS Security section is used for the following:

= To grant administration rights for the workspace

= To determine access to the workspace by a client

The WS Security section is accessed as follows:

1. On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.
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N o a 0

Select the machine defined in "Configuring Oracle Connect for CICS" on
page 2-18.

Right-click the machine and choose Open Runtime Perspective.
Drill-down the daemon to display the workspaces in the Runtime Explorer.
Right-click the workspace and choose Edit Workspace Configuration.
Choose the WS Security tab.

After making changes to the daemon, right-click the daemon and choose
Reload Configuration.

Note: You can also change workspace settings in the using the
Configuration Explorer, by selecting a machine and drilling-down
the list until the daemon is displayed. Drill-down the daemon to
list the workspaces. Right-click the workspace and choose Edit
Workspace.

Changes made to the daemon configuration in the way are not
implemented. They are only implemented after the configuration is
reloaded using the Reload Configuration option in the Runtime
Manager.
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—'wWorkspace access

—Workspace users
% pll users

' Selected users only

fdd user |
Add group |
Rename |
Remaye |

™ Enable port range

Franm park I 1]
Tio port I 1]

V¥ Use specific workspace account

‘Waorkspace account I default

¥ allow anonymous client login to server account

Anonymous dient account I default

— Administration

% pll users

' Selected users only

— Administrakor privileges for the workspace

Add user: |
Add group |
Fename |
Remaove |

v aliow lisking

Diaemaon Conkrol |Daem0n Logging |Daem0n Security |WS Infa. |WS Server |WS Logging | WS Security | WS Governing |Source

The following fields are displayed:

Administration - Identifies the users (accounts) allowed to perform administrative
tasks (tasks that require administrative login) on this workspace. For example, a
user with administrative rights to a workspace can refresh the specific workspace
servers using the IRPCD command with the Refresh workspace option.

Administrator privileges - Identifies the users (accounts) allowed to perform
administrative tasks to the workspace (tasks that require administrative login).

All users - Anyone can access the workspace and change the settings.

Selected users only - The names of users (accounts) and groups that can be
administrators.

2

2 The name is prefixed with '@, to utilize the operating system GROUP feature.
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Note: If a user is not specified, the users specified in the
Workspace users field (see below) have administrator rights for
this workspace. In this case, if all users are allowed for the
Workspace users field, all users have administrator rights for
this workspace.

Allow Listing - Determines whether this workspace appears in the list of
workspaces.

Workspace access - Defines the users (accounts) allowed to access this workspace.

Workspace users - Lists the users who are allowed to use the workspace (after
logging on). If All users is specified, any user who has logged on to the daemon
can use the workspace.

All users - Any user who has logged on to the daemon can use the
workspace.

Selected users only - The names of users (accounts) and groups that can
use the workspace.?

Note: If a user is not specified, any user who has logged on to the
daemon can use the workspace.

Enable ports range - The firewall ports through which you access the
workspace. Specifies the range of ports available for this workspace when
starting server processes. Use this option when you want to control the port
number, so that Oracle Connect for CICS can be accessed through a firewall.

Use specific workspace account - The operating system account used for the
workspace. If not specified, the account name that was provided by the client is
used.

Allow anonymous client login to server account - Whether this workspace can
be invoked without authentication (user name/password). If anonymous login
is allowed, specify the server account name to use. If this field is not specified,
the value in the Workspace account field is used.

3 The name is prefixed with '@, to utilize the operating system GROUP feature.
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COBOL APIs to Applications

The Oracle Application Server Integration Adapter for CICS includes a set of APIs
that enable sending a native event as an inbound interaction from a COBOL
program.

To use the APIs, you must include the following in the COBOL program:

The ACXAINIT function - This function loads the API functions. The function
does not have any parameters

Link the COBOL program with the stub INSTROOT.FIXLIB (ACX3GL), where
INSTROOT is the high-level qualifier where Oracle Connect for CICS is
installed

This appendix describes the APIs and functions:

Connection APIs
Transaction APIs

The Execute Function
The Get Event Function
The Ping Function

The Get Error Function

See Also: "Sending Inbound Interactions Using a CICS
Transaction" on page 5-2 for details of how to use a CICS
transaction that calls the APIs instead of using the APIs
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Connection APIs

The following functions handle the connection and connection context for an
inbound interaction:

s The Connect Function
s The Disconnect Function
There are two kinds of connections:

Transient Connection - Transient connections are created for use within a single
inbound interaction. A transient connection is disconnected when an inbound
interaction ends, or when the connection context changes (that is, with the
connect, setConnection or disconnect functions).

Persistent Connection - Persistent connections can persist across multiple inbound
interactions or connection context changes. Persistent connections are disconnected
upon an explicit disconnect function or when a connection idle timeout expires.

The Connect Function

The Connect function establishes a new connection context. All the interactions
defined take place within a connection context.

Upon a successful connect, a connection context is established and an implicit
setConnection is performed with the newly created connection ID. A failed
connect function leaves the inbound interaction with no connection context (that
is, if a connection context was established prior to invoking the connect function,
that connection context will no longer be in effect).

The function returns an integer of 1 (TRUE) or 0 (FALSE), to determine the success
of the function.

Syntax

ACXACNCT using ServersUrls Username Password Workspace AdapterName Persistent IdleTimeout
ConnectMode DefinitionFileName KeyName KeyValue ConnectHandle
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Table D-1 ACXACNCT Parameters

Parameter

Usage

Description

ServersUrls

Username
Password

Workspace

AdapterName

Persistent

IdleTimeout

ConnectMode

Input

Input
Input
Input

Input

Input

Input

Input

DefinitionFileName Input

The address of the server being connected to in the format:
server_name:port.

Or:

TCP/IP_address:port.

A series of servers, separated by commas, can be specified.
The connection is made to the first server, in the list, that is up

The username required by the adapter
The user password required by the adapter

Optional. The name of the workspace where the adapter
associated to the connection runs. The default workspace is
Navigator

The name of the adapter to connect to

To supply the adapter schema as a parameter for the
ACXACNCT call, build an ESDS VSAM file, which holds the
adapter definition. Insert the schema into this VSAM file

You can insert the schema into the VSAM file by creating a
table with one column with a datatype of char X and use an
INSERT INTO SQL statement to enter the data

Persistent connection indication. If true, a persistent
connection is created. Otherwise a transient connection is
created. The defaultis false.

A per-connection client idle timeout setting (in seconds). If the
client does not use the connection for the specified amount of
time, the connection is disconnected by the server and its
associated resources released. This setting is limited by the
server side maximum idle connection timeout setting

The mode of the connection:
0 - Immediate connection

1 - Deferred connection - the connection is made when the
execute function is performed

The name and path of the local definition used for the adapter.
If omitted, the API queries the underlying adapter for the
metadata

This parameter should be specified, when the adapter is
remote
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Table D-1 (Cont.) ACXACNCT Parameters

Parameter Usage Description

KeyName Input  The name of the encryption key

KeyValue Input  The value associated with the encryption key
ConnectHandle Output A pointer to the connection. A pointer is always returned

when the connection fails. This enables calling the getError
function to determine what caused the error

The Disconnect function must always be called to clear the
connection handle

The Disconnect Function

The Disconnect function destroys the current connection context. All the
resources associated with the current connection (persistent or transient) are
released.

Syntax
ACXADSCO using ConnectHandle

Table D-2 ACXADSCO Parameters

Parameter Usage Description

ConnectHandle  Input A pointer to the connection

Transaction APIs
Transaction APIs are used in the following scenarios:

Non-transacted operation - The adapter works in auto-commit mode. Work is
committed immediately and automatically upon execution. This operation mode is
the default operation mode when no transaction APIs are used, or when the
setAutoCommit function sets auto-commit to true.

Local transaction operation - When auto-commit is set to false, the first interaction
starts a transaction that lasts until an explicit commit (using the
transactionCommit function) or an explicit rollback (using the
transactionRollback function) occurs. All interactions performed in between
are part of that transaction.
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Note: 'local'is used here to indicate the scope of the transaction,
rather than its location: the local transaction may be running on a
remote machine.

The following functions handle transaction operations:
s The Set Autocommit Function
s The Transaction Commit Function

s The Transaction Rollback Function

The Set Autocommit Function

The Set Autocommit function sets the auto-commit mode of the connection.

Syntax
ACXASCMT using ConnectHandle AutoCommit

Table D-3 ACXASCMT Parameters

Parameter Usage Description
ConnectHandle  Input A pointer to the connection.
AutoCommit Input New auto-commit mode of the connection. If set to true, each

interaction immediately commits once executed. The
auto-commit mode must be turned off if multiple interactions
need to be grouped into a single transaction and committed or
rolled back as a unit

When auto-commit is reset and no global transaction is in
progress, any interaction starts a local transaction. The client is
required to use transactionCommit or transactionRollback at
the appropriate time to commit or rollback the transaction

The auto-commit mode is true by default and is reset if a
distributed (global) transaction is started

The Transaction Commit Function

The Transaction Commit function commits the work done under the global or
local transaction.
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Syntax
ACXACMIT using ConnectHandle Xid

Table D-4 ACXACMIT Parameters

Parameter Usage Description
ConnectHandle  Input A pointer to the connection.
Xid Input For internal use only. Supply an empty value

The Transaction Rollback Function

The Transaction Rollback function rolls back the work done under the
(global) transaction.

Syntax
ACXARBCK using ConnectHandle Xid

Table D-5 ACXARBCK Parameters

Parameter Usage Description
ConnectHandle  Input A pointer to the connection
Xid Input For internal use only. Supply an empty value

The Execute Function

The Execute function executes a given interaction against the application. The
function supplies the input record that is required by the application.

Syntax
ACXAEXEC using ConnectHandle InterationName Bufferln BufferOut BufferOutLen

Table D-6 ACXAEXEC Parameters

Parameter Usage Description

ConnectHandle  Input A pointer to the connection
InteractionName Input Name of interaction to execute

BufferIn Input A pointer to the input record

BufferOut Output  For internal use only. Supply an empty value
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Table D-6 (Cont.) ACXAEXEC Parameters

Parameter Usage Description

BufferOutLen Output  For internal use only. Supply an empty value

The Get Event Function

The Get Event function determines the event to wait for and how long to wait.
When an event is received, the function returns the results of performing the event.

Syntax
ACXAGTEYV using ConnectHandle EventName Wait Keep BufferOut BufferOutLen

Table D-7 ACXAGTEV Parameters

Parameter Usage Description

ConnectHandle  Input A pointer to the connection

EventName Input Name of event to wait for

Wait Input Length of time to wait to receive the event, in seconds
Keep Input Whether the event should be stored in the repository or

deleted once finished. The default is false (to delete the event)
BufferOut Output A pointer to the output record
BufferOutLen Output  The length of the output record

The Ping Function

The Ping function returns, in a pingResponse response, information about an
active adapter.

Syntax
ACXAPING using ConnectHandle OutputStruct

Table D-8 ACXAPING Parameters

Parameter Usage Description
ConnectHandle  Input A pointer to the connection
OutputStruct Output  The return information describing the structure of the adapter
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The Get Error Function

The Get Error function returns error information.

Syntax
ACXAGTER using ConnectHandle Error Status

Table D-9 ACXAGTER Parameters

Parameter Usage Description

ConnectHandle Input A pointer to the connection

Error Output  The error message returned by the function
Status Output  The status of the returned error
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National Language Settings

National Language Support (NLS) is provided by the Oracle Application Server
Integration Adapter for CICS for the following languages:

Arabic

English (the default)
Hebrew

Japanese

Korean

Simple Chinese
Spanish

Traditional Chinese

This appendix describes how to set up language support.
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Defining the Language and Codepage

1.  On the machine where Oracle Studio is installed, from the Start menu, choose
Start > Programs > Oracle > Studio > Studio.

2. Select the machine defined in "Configuring Oracle Connect for CICS" on
page 2-18.

3. Right-click the NAV binding node and Choose Edit Binding.

4. In the Binding Properties tab, click the + next to the misc node.

@Eonﬁguration - Oracle Studio for Legacy adapters
File Edit - Search ‘Window Help

=10l x|

| -|HR&] ¥

ﬁ ﬁ' Configuration Explorer = E X ]
@ ED Machines
El@ 05350 Cakegory: IAII 'l
=7 Bindings
EE MaY —Environment propetties
EI Daemans
B Users
= Propetk | Yalue |
comm
debug
=l rise
codepage
cvkSeverityLevel i}
edit
_
nlsstring Restore field |
tempDir Restore all |
wearZ2000Policy 5
odbc Create Environment |
oledb
aptimizer St koA,
queryProcessar
kransackions
[ Properties 5 :%:D @ x [+ turing
Propert | Yalue
Mame Y
Path {05390\ bindings kA
Warkspace MNAYIGATOR
Properties |Machines |Source

5. Enter a valid value for the language. The following language codes are valid:
ARA - Arabic
ENG - English
HEB - Hebrew
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JPN - Japanese

KOR - Korean

SCHI - Simple Chinese

SPA - Spanish

TCHI - Traditional Chinese

Optionally, in the codepage field, specify the codepage required.

You can skip this step, and just specify a language (see the previous step). In
this case, a default codepage is used. The following shows the default
codepages:

ARA - AR8ISO8859P6

ENG - EBCDIC

HEB - IWS8EBCDIC424

JPN - JA1616DBCS

KOR - KO16DBCS

SCHI - ZHS16DBCS

SPA - WESEBCDICLATIN

TCHI - ZHT16DBCS

The following table lists the supported codepages according to language:

Table E-1 Supported Codepages

Language Supported Codepage Values Description

Arabic ARBSISO8859P6 ISO 8859-6 Arabic (ASCII)

English EBCDIC -

English D8EBCDIC273 EBCDIC codepage 273 8-bit Austrian German
English DKSEBCDIC277 EBCDIC codepage 277 8-bit Danish

English SS8EBCDIC278 EBCDIC codepage 278 8-bit Swedish

English ISEBCDIC280 EBCDIC codepage 280 8-bit Italian

English WESEBCDIC285 EBCDIC codepage 285 West European
English FSEBCDIC297 EBCDIC codepage 297 8-bit French
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Table E-1 (Cont.) Supported Codepages

Language Supported Codepage Values Description
English WESEBCDIC500 EBCDIC codepage 500 West European
Hebrew IWSEBCDIC424 EBCDIC codepage 424 8-bit Latin/Hebrew (new EBCDIC)
Hebrew IWSEBCDIC806 EBCDIC codepage 806 8-bit Latin/Hebrew (old EBCDIC)
Japanese JA16DBCS IBM EBCDIC 16-bit with Latin characters
Japanese JA16EBCDIC930 IBM DBCS codepage 390 16-bit
This codepage has no encoding for lowercase Latin
letters. All resources should be defined in uppercase.
Korean KO16DBCS IBM EBCDIC 16-bit
Simple Chinese ZHS16DBCS IBM EBCDIC 16-bit Simple Chinese
Spanish WESEBCDICLATIN EBCDIC codepage with Spanish extensions
Spanish WESEBCDIC284 EBCDIC codepage 284 8-bit Latin American/Spanish

Traditional Chinese ZHT16DBCS

IBM EBCDIC 16-bit Traditional Chinese

Note: The Codepages for the European languages are based on
English being chosen as the language in the Language field.
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acxTrace parameter, 7-7
analyzerQueryPlan parameter, 7-7
application language

parameter, 7-8
autocommit

setting using setAutoCommit verb, D-5

buffer size
comCacheBufferSize parameter, 7-6

Cc

CD-ROM drive requirements
IBM S/390, 2-2
PC, 2-3
COBOL, D-6
execute function, D-6
COBOL API
connect verb, D-2
disconnect verb, D-4
setAutoCommit verb, D-5
transaction verbs, D-4
transactionCommit verb, D-5
transactionRollback, D-6
codepage parameter, 7-7
comCacheBufferSize parameter, 7-6
comm parameters
comCacheBufferSize, 7-6
comMaxSocketSize, 7-6
comMaxXmlSize, 7-7

IndeXx

comMaxSocketSize parameter, 7-6
comMaxXmlSize parameter, 7-7
committing a transaction, D-5
connect verb, D-2
connecting

connect verb, D-2

using COBOL, D-2
connection

destroying with disconnect, D-4
cvtSeverityLevel parameter, 7-7

D

daemon
logging, C-4
security, C-7
server modes, 7-3
shutting down, 6-6
starting, 6-5
timeout, 6-14
workspaces, 6-5
daemon configuration
logging section, C-4
security section, C-7
data type conversions
cvtSeverityLevel parameter, 7-7
data types
cvtSeverityLevel, 7-7
nlsString, 7-8
datatypes
metadata atomic datatypes, B-2
debug environment parameters, 7-7
debug parameters
acxTrace, 7-7

Index-1



analyzerqueryPlan, 7-7
generalTrace, 7-7
logFile, 7-7
oledbTrace, 7-7
optimizerTrace, 7-7
queryWarnings, 7-7
traceDir, 7-7

disconnect verb, D-4
disk space requirements

IBM S/390, 2-2
PC, 2-3

edit parameter, 7-8
environment parameters

acxTrace, 7-7
analyzerQueryPlan, 7-7
codepage, 7-7
comCacheBufferSize parameter, 7-6
comMaxSocketSize, 7-6
comMaxXmlSize, 7-7
cvtSeverityLevel, 7-7
debug, 7-7

edit, 7-8
generalTrace, 7-7
language, 7-8

logFile, 7-7
miscellaneous, 7-7
nlsString, 7-8

odbc, 7-9

oledb, 7-9
oledbTrace, 7-7
optimizer, 7-9
optimizerTrace, 7-7
queryProcessor, 7-9
queryWarnings, 7-7
tempDir, 7-8
traceDir, 7-7
transactions, 7-9
tuning, 7-9
year2000Policy, 7-8

error log

logFile parameter, 7-7

execute function, D-6
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G

generalTrace parameter, 7-7

H

hardware requirements
IBM S/390 CD-ROM drive, 2-2
IBM S/390 disk space, 2-2
IBM S/390 memory, 2-2
IBM S/390 processor, 2-2
PC CD-ROM drive, 2-3
PC disk space, 2-3
PC memory, 2-3
PC processor, 2-3

IBM S/390
installation, 2-7
postinstallation, 2-12
preinstallation, 2-6
installation
IBM S/390, 2-7
installing
Windows, 2-18

L

language parameter, 7-8
log files
daemon options, C-4
logFile parameter, 7-7
logFile parameter, 7-7
logging
optimizer strategy, 7-7
trace information, 7-7

maximum size, 7-7
memory requirements
IBM S/390, 2-2
PC, 2-3
metadata
atomic datatypes, B-2



Microsoft software requirements, 2-4
miscellaneous environment parameters, 7-7
miscellaneous parameters

codepage, 7-7

cvtSeverityLevel, 7-7

edit, 7-8

language, 7-8

nlsString, 7-8

tempDir, 7-8

year2000Policy, 7-8

N

NAV_UTIL
text editor, 7-8
nlsString parameter, 7-8

(0]

odbc environment parameters, 7-9
oledb environment parameters, 7-9
oledbTrace parameter, 7-7
operating system requirements

IBM S/390, 2-3

PC, 24
optimizer environment parameters, 7-9
optimizer files

traceDir parameter, 7-7
optimizer plan

writing to file, 7-7
optimizerTrace parameter, 7-7
Oracle Application Server ProcessConnect

requirements, 2-3

P

postinstallation
IBM S/390, 2-12
preinstallation
IBM S/390, 2-6
processor requirements
IBM S/390, 2-2
PC, 23

Q

query optimizer
logging strategy, 7-7
writing plan to file, 7-7
query optimizer files
traceDir parameter, 7-7
queryProcessor environment parameters, 7-9
queryWarnings parameter, 7-7

R

requirements
IBM S/390 hardware requirements, 2-2
IBM S/390 software requirements, 2-2
PC hardware requirements, 2-3
PC software requirements, 2-3

rolling back transactions, D-6

S

server modes
configuring, 7-3
servers
reusable, 7-4
Reuse limit daemon parameter, C-14
ReuseLimit daemon parameter, 7-4
setAutoCommit verb, D-5
SMS
system managed storage, 2-6
sockets
comMaxSocketSize parameter, 7-6
software
Microsoft products, 2-4
software requirements
IBM S/390 operating system, 2-3
Microsoft, 2-4
Oracle Application Server ProcessConnect,
PC operating system, 2-4
system managed storage
SMS, 2-6

T

2-3

tempDir parameter, 7-8
temporary files
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tempDir parameter, 7-8
timeout
clientidle, 6-14
trace information
logging, 7-7
traceDir parameter, 7-7
transaction verbs, D-4
transactionCommit verb, D-5
transactionRollback verb, D-6
transactions
committing with transactionCommit, D-5
rolling back with transactionRollback, D-6
transactions environment parameters, 7-9
tuning environment parameters, 7-9

\")
verbs

connection, D-2
w
Windows

installing, 2-18
X

XML documents, 7-7
maximum size, 7-7

Y

Y2K
year2000Policy parameter, 7-8
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